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 Overview
Timbuktu Pro allows you to connect your PC to other Windows and Macintosh computers on your 
network.

Timbuktu Pro System Requirements 
Start Timbuktu Pro 
The Timbuktu Pro Window  
Exit Timbuktu Pro without shutting it down 
Shut down Timbuktu Pro 

Timbuktu Pro's seven services allow you to:
Send FlashNotes and files to other users 
Exchange files between computers
Control another user's computer
Observe another user's screen 
Request Notification when a remote user is active    
Chat with a Remote User 
Speak to a Remote User 

The subtopics under Overview:
Connecting to other computers
What connecting means
How secure can I be?  
Using the address books 
What is Send? 
What is Exchange? 
What is Remote Control? 
What is Notify?  
What is Chat?
What is Intercom?



 Timbuktu Pro System Requirements
To run Timbuktu Pro for Windows, your PC must meet the following hardware and software requirements:

Minimum hardware requirements:
For Windows 95

n 486 CPU or better
n 8MB of RAM; we recommend 12MB
n 15MB free disk space
n Network adapter hardware configured to work with your networking software

For Windows NT 4.0
n 486 CPU or better
n 16MB of RAM
n 15MB free disk space

Intercom System requirements:
n At least a 486 DX2 66MHz processor; a Pentium is preferred
n An operating system supported sound card
n Speaker(s)
n A microphone

Minimum software requirements:
n Microsoft Windows 95, or Windows NT 4.0

Note: Timbuktu Pro 32 does not support Windows 3.11, Windows for Workgroups and Windows 3.51.
n TCP/IP Microsoft networking software that is installed and running.

Compatibility
n Timbuktu Pro 1.5 or higher for Windows
n Timbuktu for Macintosh Version 4.0.2 or higher



 Start Timbuktu Pro
Start Timbuktu Pro by clicking the Start menu>Programs>Timbuktu Pro>Timbuktu Pro.

To keep your computer available for access by remote users, Timbuktu Pro must not be shut down; 
however, you can minimize it to a tray icon to keep your desktop uncluttered. You can re-start Timbuktu 
Pro by double-clicking the icon in the system tray on the task bar.

The Timbuktu Pro Window 
Exit Timbuktu Pro without shutting it down 
Shut down Timbuktu Pro 



 The Timbuktu Pro Window 
Starting Timbuktu Pro displays the following window. The Timbuktu Pro window contains all the menus 
and buttons you'll use to configure your Timbuktu Pro and connect to remote computers.

The main window    has three tabs: Address Books, Recent Connections and TCP/IP. At the bottom of the 
window there is a status bar.      Related status messages or tooltips are displayed in the status bar.    Your 
IP address is displayed at the lower right of the status bar.

Timbuktu Pro Service Toolbar 
Connection tabs 



 Exit Timbuktu Pro without shutting it down
When you exit the application without shutting it down, Timbuktu Pro continues to run in the background. 
This gives remote users the ability to connect to your PC even though you aren't making any outgoing 
connections. Timbuktu Pro reminds you that it is running in the background by placing its icon in the 
system tray on the task bar.

To exit without shutting down Timbuktu Pro:
1 Choose Exit from the File menu. Exiting Timbuktu Pro closes the Timbuktu Pro window. 
2 Double-click on the Timbuktu Pro task bar icon to restore the window.



 Shut down Timbuktu Pro
If you want to bring an end to all Timbuktu Pro activities and not have Timbuktu Pro running in the 
background, you must shut down the application. When you shut down the application, users can no 
longer connect to your Timbuktu Pro computer.

To shut down Timbuktu Pro:
Choose Exit and Shut Down Timbuktu Pro from the File menu. If any connections are active then they will
be shut down.

When Timbuktu Pro is minimized:
Click the right mouse button on Timbuktu Pro icon in the system tray on the task bar. 
Choose Exit and Shut Down Timbuktu Pro from the menu. If any connections are active then they will be 
shut down.

Note: Timbuktu Pro saves the settings before shutdown. For example, if you shut down when Timbuktu 
Pro is minimized, then the next time you launch Timbuktu Pro it will be minimized. If you shut down 
Timbuktu Pro when the main window is open, the next time you launch it the main Timbuktu Pro window 
will be open.



 Timbuktu Pro Service Toolbar
The Timbuktu Pro Service Toolbar has a button for each service.    The icons on the toolbar have 4 
different states: unavailable, available, mouse over, and mouse down. These states are described below:

Unavailable State:
The unavailable state looks like this:

                                                            Unavailable State Toolbar

An icon is in this state when:
n No machine is selected in the Address Books tab or Recent Connections tab
n No IP address is entered in the address field of the TCP/IP tab .
n Hardware is missing.

For example: Intercom is unavailable because there is no sound card, or if your sound card is 
misconfigured.

n A session is already in progress.
For example: You cannot start a new Exchange session if an earlier Exchange session is still open.

The unavailable state also affects the Services menu. You cannot access the unavailable services from 
the Services menu. 

Available State:
The available state looks like this:

                                                            Available State Toolbar

The icon is in this state when:
n A machine is selected in the Address Books tab or Recent Connections tab
n An IP address is entered in the address field of the TCP/IP tab .

Mouse Over State:
The mouse over state looks like this:

                                                    Mouse Over Exchange Icon
 
When you move the mouse over the icon it changes color and a square button highlights around the icon 
giving it a raised look. The Exchange icon is highlighted in the Services Toolbar shown above. All the 
other icons, except Intercom, are in the available state.

Here is what all the icons look like when colorized:

                                                                        Colorized Toolbar



Mouse Down State:
The mouse down state looks like this:

                                                            Mouse Down on an Icon Toolbar

This is shown when the left mouse button is pressed.    Notice the square button looks like it’s being 
pressed into.



 Connecting to other computers
You can connect to another computer as either a registered user or as a guest user using the Send, 
Exchange, Control or Observe, Chat, Intercom or Notify service. If you connect as a registered user, you 
are required to log on with your name and a password.

You can connect to any other computer that is running Timbuktu Pro for Windows, or Timbuktu Pro for 
Macintosh over a TCP/IP network.

To connect to a remote computer with TCP/IP:
1 In the TCP/IP connection tab, type the TCP/IP address of the computer you want to connect to.
2 From the Services menu, choose a service you want to use or click an icon on the Services toolbar.
3 After you have chosen a service, three things can occur:

a. Your session begins immediately.

b. Login window is displayed.
        Logging on 

c. No connection is made.
        When you can't log in 

4 Timbuktu Pro displays a session window. The title bar of this window displays the name of the remote 
computer you are connecting to.



 When you can't log in
Your attempt to contact a Timbuktu Pro computer may have failed for one of the following reasons:

n You may have typed the wrong IP address or Internet Name.
n The computer you were trying to reach has been shut down.
n Timbuktu Pro may not be running on the other computer.
n The computer you are trying to reach may be temporarily busy rendering a complex image, displaying 

a movie, or performing a spreadsheet calculation. Wait a while and try again.
n There may be trouble with the network, the telephone, or a computer connection. A phone line may be 

noisy, a network router may be down, a connector may be unplugged, or a cable may be damaged.
n Timbuktu Pro may not be installed on the other computer.
n The Timbuktu Pro computer may be located behind an Internet firewall. This can be confusing 

because Timbuktu Pro can prompt you for a login, but you won't be allowed to connect to the remote 
computer. You'll need to ask for help from your network manager or Internet service provider. 

n Another user is already connected to the remote computer you are trying to connect to.
n Your TCP/IP network is not configured correctly.



 What connecting means 
While Timbuktu Pro is running, you are able to connect to other computers, and, if you have granted the 
appropriate privileges, others may be able to connect to you. 
Connecting to other computers

Your PC can be connected to other Timbuktu Pro users over TCP/IP. Connection tabs allow you to 
connect over TCP/IP only if the appropriate network protocol has already been installed in your PC. For 
example, if the TCP/IP tab does not appear in the main Timbuktu Pro window, your computer is not 
currently running its TCP/IP software.
How secure can I be? 

If you want your computer to be available to other Timbuktu Pro users while Windows is running, you can 
minimize Timbuktu Pro to an icon in the system tray on the task bar and continue working on other 
Windows applications.
When you exit and shut down Timbuktu Pro, remote users cannot connect to your PC via Timbuktu Pro.



 How secure can I be?
Timbuktu Pro provides a comprehensive and flexible set of security options. No remote users can connect
to your PC for any purpose without your authorization.

Security

You have several levels of control over others' access to your PC.
When you configure Timbuktu Pro, you can change your computer name, define a master password for 
Timbuktu Pro, and set a reserve space and files received directory for receiving files from other users.
Setting your preferences 

When you want another user to connect to your computer, you can create a registered user account and 
Windows NT account that assigns privileges.
Adding new registered users 
Changing a registered user account    
Removing registered users    

When you choose to allow Timbuktu Pro users to connect to your PC, you can define the types of 
passwords that your registered users can use for access. Registered users can change their own 
passwords for your PC, but you can restrict the range of passwords that can be used.
Setting password restrictions for registered users 

When you want to grant attended access to a temporary guest, disconnect a current user, clear previous 
users from the user log, or view the activity log, you can use the Connections menu.
Admitting a temporary guest 
Disconnecting a remote user 
Clearing previous users
Checking the activity log

When you want to leave your PC as accessible to your users as it is to you, you can allow unrestricted 
guest access.

Allowing unrestricted guest access

When you want to connect to another computer that is running Timbuktu Pro, you may be required to log 
on to that computer.
Logging on

Whenever you exit the Timbuktu Pro application, no other users can connect to your PC.
Shut down Timbuktu Pro 



 Using the address books
The Address Book is a collection of Timbuktu Pro addresses.

Using Timbuktu Pro’s address books can save you time. Once you have added a TCP/IP address to your 
address book, you don’t have to type that user’s address each time you connect to that remote user.

Remote user information, like the default service, computer name, address, and the description is stored 
in the address books.

Multiple address books can be created to group addresses.

Address Books    



 What is Send?
Using the Send service is similar to sending an electronic mail message to a remote computer. Timbuktu 
Pro saves the files you send in a directory on the remote computer. The remote user can send files only 
to to the directory that you have specified. Send does not allow the remote user to see the directories on 
your PC. You can save, print, and delete the FlashNotes you have received.

Note: Send supports long file names.

File transfer
Sending FlashNotes and files



 What is Exchange?
With the Exchange service, you can copy files in both directions between your PC and a remote 
computer. Exchange provides more flexibility than Send in the following ways:

n You can see the names of the files and directories on both computers.
n You can copy files to and from any location on either computer.
n You can create a directory on either computer to receive the transferred files.
n You can remove files from either computer.

Note: Each service supports long file names.

Due to the complete access to the other computer allowed by the Exchange command, Timbuktu Pro 
users often grant this privilege as one or more subprivileges: Exchange (Write), Exchange (Read), and 
Exchange(Remove).

Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drive that you are currently logged into.
DO NOT grant Exchange privileges if your computer contains sensitive, or confidential information.

Note: NT users have full Exchange privileges.

File transfer
Exchanging files



 What is Remote Control?
When you control or observe a computer running Timbuktu Pro, the desktop activity of that computer is 
displayed in a Control window or Observe window. The window is updated as the other computer's 
desktop changes.
Remote control

When you control another computer, you can perform any of the tasks that you could perform locally, 
including opening applications, creating new files, and so on. This means that a user with the Control 
privilege can remotely create, modify or delete files without restriction, and can erase data from the 
another computer's disk. This privilege should be granted with caution.
Controlling another computer

When you observe another computer, you can see the activity on its screen, but you cannot control any of
its actions. This privilege is useful for diagnosing problems on another computer.
Observing another computer

Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drive that you are currently logged into.
DO NOT grant Exchange privileges if your computer contains sensitive, or confidential information.



 What is Notify?
With the Notify service, you can request to be notified when a Timbuktu Pro user has started using his or 
her computer. This is a useful indicator to find out if the person you want to communicate with is available.
You can then call or begin a Chat or Intercom session with the remote user. 
Requesting Notification when a remote user is active 



 What is Chat?
With the Chat service, Timbuktu Pro users post messages to one another interactively. For example, if 
you are already in the midst of a file transfer session, a Chat window lets you tell the other user which file 
is being transferred. You can save and print the chat sessions.

Chat with a Remote User 



 What is Intercom?
The Intercom service allows Timbuktu Pro users to speak to each other through their computers.

Speak to a Remote User 
System Requirements for Intercom Service 



 About Timbuktu Pro
The About Timbuktu Pro window displays information about the product like the Timbuktu Pro version and
the product code.



 Network Neighborhood Extensions
The Network Neighborhood Browser Extension gives you access to Timbuktu Pro on remote computers 
without opening the Timbuktu Pro main window.    Right clicking on a Network Neighborhood computer 
invokes the Timbuktu Pro sub menu.    You can use any Timbuktu Pro Service from this menu.

Timbuktu Pro connections are limited to the TCP/IP protocol.    Since the network neighborhood gives you 
a protocol independent view of the network, you may not be able to connect to a remote computer if it is 
set up with multiple protocols other than TCP/IP.



 Timbuktu Pro Connection Document
Timbuktu Pro Desktop shortcuts allow you to start a Timbuktu Pro connection to a specific remote user 
from a desktop icon.    Desktop shortcuts are created by right mouse clicking over the desktop and 
choosing New->Timbuktu Connection Document.

Once created the shortcut can be renamed or have its properties changed by right clicking on it.    The 
shortcut properties dialog has two tabs; General and Timbuktu Pro Properties.

To change the properties:
1 Right click on the Timbuktu Connection Document. The New Timbuktu Connection document 

Properties dialog appears. 

2 Select the General tab to view the Timbuktu Pro Connection document properties such as its 
name, location and size. The MS-DOS name and the date and time of when the document was created, 
last modified, and accessed, are also displayed.
3 You can specify the attributes of the document as either Read-only, Hidden, Archive or System.

4 Select the Timbuktu Pro Properties tab.



5 Modify the remote computer address by typing in the address field.
6 Modify the Default Service by choosing a service from the drop-down list.

To use a Timbuktu Connection Document:
1 Double-click or right-click on the Timbuktu Connection document.
2 Select a service from the Timbuktu Pro menu.



 File transfer
Timbuktu Pro provides two file transfer services: Send and Exchange. You can use a service either by 
clicking its button in the main Timbuktu Pro window or by choosing its command from the Services menu. 
Notice that the Send and the Exchange service is enabled only if an address is selected in a connection 
tab.

Sending FlashNotes, files, and folders:

 Choose Send to send a FlashNote, files, and folders to another user.

Send FlashNotes and files and folders to other users 

The subtopics under Send:

Enclosing files in a FlashNote reply  
Selecting files to send 

Receiving FlashNotes, files, and folders:

Receiving FlashNotes, files, and folders 
Setting the files received folder
Saving and Printing a FlashNote 
Deleting a FlashNote 

Exchanging files and folders:

Exchanging files



 Send FlashNotes and files to other users
Using the Send command is similar to sending an electronic mail message to another computer. 
Timbuktu Pro saves the files you send in a directory on the remote computer. Likewise, the remote 
user can send files only to your files received folder. Send does not allow the remote user to see the 
directories on your PC.

To Send FlashNotes and Files:
1 Select the remote address.
2 Choose Send from the Services menu. The Send window is displayed.

3 To send a note, type a message in the upper panel. If you don’t type a note, Timbuktu Pro sends 
a default note indicating the default service, computer name, address, and the description.
4 To include files with your message, click the Add Files button and make your selection in the Add 
Files to Note window.    
Selecting files to send 

5 Click the Send button in the Send window, to send the note and the attached files. You may be asked 
to log in.

6 The remote user can view, save, or print incoming FlashNotes. The attached files can also be saved.
Saving and Printing a FlashNote 

7 To stop a file transfer immediately, click the Cancel button.
(Timbuktu Pro stops the file transfer, however the note is still sent to the remote user. Stopping the file 
transfer does not affect the files that have already been transferred.)

While Timbuktu Pro is sending files, you can:
n Click outside the FlashNote window to work on other computer tasks.



 Selecting files to send
To select a file from the Add Files to Note window:

1 To include files with your message, click the Add Files button and make your selection in the Add Files
to Note window.

2 Locate and display the source folder in the upper panel. To select a different drive, click the down 
arrow in the (drive) field and choose the desired drive from the drop-down list.
3 Select the files you want to add in the upper panel and click the Add button. The files that you 
select in the upper panel appear in the lower panel.

4 You can select multiple items in a file list.
Selecting Multiple Items in a File List 

5 Repeat steps 2 and 3 to include additional items.
6 If you wish to remove a file that you added, select the file in the lower panel and click the Remove 

button.
7 Click the Done button when you have finished selecting the files that you want to add to the note. This 

returns you to the FlashNote window.



 Saving and Printing a FlashNote
The FlashNote window appears when you receive a FlashNote from a remote user.

To save and print a FlashNote:
1 The remote user can save the notes and the attached files by clicking the Save Note or the Save Files

button, respectively. 
2 The flashnotes can be printed by clicking the Print Note button.
3 Click Save Files to save the attached files. This displays the Save Files window.
4 Select the folder(s) to which enclosures should be copied. The Save Files button is enabled by default 

if the FlashNote contains enclosures. 
5 Click Save Note to save a flashnote and Print Note to print the flashnote. The FlashNotes are saved 

with a default .rtf    extension.



 Enclosing files in a FlashNote reply 
Suppose that you have just received a flashnote requesting a file and you need to send a file back to the 
remote user.

To enclose a file in your reply:
1 Click Reply.
2 Click Add Files to select the desired files or folders.
3 Browse to locate the files you want to send. To select a different drive, click the down arrow in the 

(drive) field and choose the drive from the drop-down list. Select the directory. To display the contents 
of the directory, double-click it.

4 The source directory    is displayed in the upper panel.
5 Select the files you want to send from the upper panel and click the Add button. The files that you 

select in the upper panel appear in the lower panel. If you wish to remove a file that you added, select 
the file in the lower panel and click the Remove button.

6 You can select multiple items in a file list.
Selecting Multiple Items in a File List 

7 Click the Done button when you have finished selecting the files that you want to add to the note.
8 Type a reply note.
9 Click the Send button in the Send window, to send the note and files.

Note: You may be asked to log in.



 Receiving FlashNotes, files, and directories
Remote users can transfer files to your computer using either the Send or the Exchange service. You can 
receive files from a Macintosh or a PC. File transfers can be stopped at any time. You can also restrict the
ability of remote users to transfer files to your Timbuktu Pro desktop.

If you are receiving notes and files via the Send service:
Timbuktu Pro can be set (in the Preferences dialog box) to display an incoming note in one of two ways:

n In a window
n As an icon

If you have selected the Minimized on the taskbar option, the FlashNote will appear on the taskbar. You 
can click the icon to display the FlashNote.

Once you have opened the FlashNote, check to see if any files or folders have been attached to it. If no 
files have been attached, you can either discard the note, print the note, save the note, or reply to it.

n If you want to discard the note, click the Delete button.
n If you want to reply to the note:
1 Click Reply.
2 Type your response in the FlashNote window.
3 Click Send. The message is sent immediately.

If you have received a FlashNote with files attached, you have one more option:
n Save the enclosures

Save files you receive with FlashNotes

If you are receiving files via the Exchange service:
The exchange takes place in the background, so your work is not interrupted by dialog boxes or alerts.

If you want to restrict remote users’ ability to connect to your Timbuktu Pro:
You can restrict user access from the Security window.

Stopping a file transfer



 Deleting a FlashNote
To delete a FlashNote:

1 Click the Delete button in the FlashNote window. Timbuktu Pro asks you to confirm the deletion.
2 Click Yes to continue. This will delete the flashnote and any unsaved enclosures.



 Setting the files received directory
Files transferred using the Send function are stored in a files received folder. You can set the location of 
the files received folder on your PC.

To set your files received folder:
1 Choose Preferences from the Setup menu.
2 Click on the Send tab.
3 Click on the Browse button.
4 Select a folder for the drives listed.
5 Click OK.



 Save files you receive with FlashNotes
To save a received file or folder:

1 Click the Save Files button in the FlashNote window. The Save Files dialog box appears.
2 Select a different target drive if necessary.
3 Select the destination folder.
4 From the lower panel, select the files or folders you wish to save in this location. Click the Save button.
5 To save other received files in different locations, repeat steps 2-4. When all of the files have been 

moved, or when you click Done, the FlashNote window reappears.



 Stopping a file transfer
To stop receiving files either through Send or Exchange:

1 Display the Connections menu.
2 Choose the remote user’s name under the Disconnect All Users option.

The file transfer is halted immediately. The file that was in the process of being transferred is not 
copied, but all previously transferred files remain on the disk to which they were copied.



 Exchanging files
With the Exchange service, you can copy files to and from your PC and another computer. Exchange 
provides more flexibility than Send. 
Exchange allows complete access to the other computer allowed by the Exchange command. Timbuktu 
Pro users often grant this privilege with more sub-privileges: Exchange To (Write), Exchange From 
(Read), and Exchange (Delete).

Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drives that you are currently logged into. DO NOT grant 
Exchange privileges if your computer contains sensitive or confidential information.

Exchange supports long file names.

Note: Windows NT users have full exchange privileges. See Windows NT users.

Exchange window 
Copying files to a specific folder on a remote disk 
Copying files from a specific folder on a remote disk 
Creating a new folder on the local disk 
Create a new folder on a remote disk 
Removing files and folders from a remote computer 

Disconnect a remote user
Exit Timbuktu Pro without shutting it down



 Exchange window
The Exchange window displays the files and folders of your computer in the upper panel and the files and
folders of the remote computer that you are connected to in the lower panel.

To copy files or folders between your computer and the computer you are connected to, simply drag the 
desired items from one panel to the desired folder in the other panel. If you don't see the files or folders 
you need to access, move up or down through the folders just as you would when opening or saving a 
document with a word processor.
File menu commands

If files or folders are selected on your disk (upper panel), choosing Copy copies them to the location 
selected on the remote computer (lower panel). This command is dimmed if you haven't been granted the
Exchange (Write) service by the remote user of the computer you're connected to. See Copying files to a 
specific folder on a remote disk    .
If files or folders are selected on the remote computer (lower panel), choosing Copy copies them to the 
location selected on your disk (upper panel). This command is dimmed if you haven't been granted the 
Exchange (Read) service by the remote user of the computer you're connected to. See Copying files from
a specific folder on a remote disk .
Choosing Remove deletes the selected files and folders. This command is dimmed if you have selected 
files or folders on the remote disk but haven't been granted the Exchange (Delete) service by the remote 
user of the computer you're visiting. See Removing files and folders from a remote computer .

Choosing Create Local Folder creates a new folder in the location selected on your disk (upper panel). 
See Creating a new folder on the local disk .

Choosing Create Remote Folder creates a new folder in the location selected on the remote computer 
(lower panel). This command is dimmed if you haven't been granted the Exchange (Write) service by the 
remote user of the computer you're connected to. See Create a new folder on a remote disk .

View menu commands



Choosing List displays the items in the Exchange window in List view mode. In List view mode, only the 
icon and the folder or file name are shown.
Choosing Details displays the items in the Exchange window in Detail view mode. In Detail view mode, it 
shows the folder or file name, its size and the date and time when it was last modified.
Choosing Sort By sorts the items in the Exchange window by either their name, size, date and time when 
last modified, ascending or descending order.



 Copying files to a specific folder on a remote disk
To copy files and folders to any folder on another computer:

1 Select the remote address. 
2 Choose Exchange from the Services menu.You may need to ask for attended access from the remote 

user before continuing.

Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drives that you are currently logged into. DO NOT grant 
Exchange privileges if your computer contains sensitive or confidential information.

3 The Exchange window is displayed. The upper panel lists the drives, folders, and files on your PC. 
The bottom panel lists the same information the remote user.

4 Locate and display the source folder in the upper panel.
5 Locate and display the destination folder in the lower panel.
6 You can create a new destination folder on the remote disk.

Create a new folder on a remote disk    

7 You can select multiple items in a file list.
Selecting Multiple Items in a File List 

8 Drag the files or folders or both from the upper panel to the desired folder in the lower panel.

Timbuktu Pro begins to transfer the files immediately. The file transfer dialog box with a progress 
indicator appears.

While Timbuktu is transferring the files, you can:

n Click outside the Exchange window, or minimize it, to work on other computer tasks. Until the transfer 
ends, you'll notice a slight slowing of performance.

n Click Cancel to cancel the transfer. The file being sent when Cancel is clicked is not transferred, but 
any files that were previously sent remain in the remote folder.

When you have finished exchanging files, click the Close box.
You can also use the Exchange service while controlling or observing a remote computer.



 Copying files from a specific folder on a remote 
disk
To copy files and folders from any folder on another computer:

1 Select the remote address. 
2 Choose Exchange from the Services menu. You may need to ask for attended access from the remote

user before continuing.

Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drives that you are currently logged into. DO NOT grant 
Exchange privileges if your computer contains sensitive or confidential information.

3 The Exchange window is displayed. The upper panel lists the drives, folders, and files on your PC. 
The bottom panel lists the same information for the remote user.

4 Locate and display the source folder in the lower panel.
5 Locate and display the destination folder in the upper panel.
6 If desired, you can create a new destination folder on the local disk.

Creating a new folder on the local disk 

7 You can select multiple items in a file list.
Selecting Multiple Items in a File List 

8 Drag the files or folders or both from the lower panel to the desired folder in the upper panel.

Timbuktu Pro begins to transfer the files. The file transfer dialog box with a progress indicator appears.

While Timbuktu is transferring the files, you can:

n Click outside the Exchange window, or minimize it, to work on other computer tasks. Until the transfer 
ends, you'll notice a slight slowing of performance.

n Click Cancel to cancel the transfer. The file being sent when Cancel is clicked is not transferred, but 
any files that were previously sent remain in the remote folder.

When you have finished exchanging files, click the Close box.

Note: If you are copying files from a Macintosh, the names of the files you receive from the Macintosh 
may be altered to conform to Windows file naming requirements.

You can also use the Exchange service while controlling or observing a remote computer.



 Creating a new folder on the local disk
When copying files to a Timbuktu Pro disk, it is sometimes useful to create a new folder that will receive 
the files.

To create a new folder on the local disk:
1 In the Exchange window, select the drive and open the folder that is to contain the new folder.
2 Display the File menu in the upper left corner of the Exchange window.
3 To create a new folder on your computer, choose the Create Local Folder option.
4 Timbuktu Pro asks you to name the new folder.
5 Type the name of the new folder and click OK to create the new folder. Timbuktu Pro creates the new 

folder.



 Create a new folder on a remote disk
When copying files to a Timbuktu Pro disk, it is sometimes useful to create a new folder that will receive 
the files.

To create a new folder on a remote disk:
1 In the Exchange window, select the drive and open the folder that is to contain the new folder.
2 Display the File menu in the upper left corner of the Exchange window.
3 To create a new folder on the remote computer, choose the Create Remote Folder option.
4 Timbuktu Pro asks you to name the new folder.
5 Type the name of the new folder and click OK to create the new folder. Timbuktu Pro creates the new 

folder on the remote disk.



 Removing files and folders from a remote 
computer
To remove files or folders from a remote computer:

1 Choose Exchange from the Services menu.
2 Select the remote address. You may need to log on and ask for permission from the remote user 

before continuing.
3 In the Timbuktu Pro (lower) panel of the Exchange dialog box, open the necessary drive and folder 

and select the file or sub-folder that you want to remove.
4 Display the File menu in the upper left corner of the Exchange window.
5 Choose Remove. Timbuktu Pro displays a message asking you to confirm your decision.
6 Click Yes.

Note: If you're not able to connect, it could mean that Timbuktu Pro is not running on the computer you 
are trying to contact or that another user is connected to that Timbuktu Pro. Either contact the remote 
user or wait a while and try again.

The remote computer you are connecting to may let you begin a session and then refuse to remove the 
items you have selected. This means that the Exchange (Delete) sub-service is not granted to your 
registered user account. You may be able to obtain this sub-service on a temporary basis by contacting 
the remote user.

Windows NT Users 



 Stop receiving files from a user
To stop receiving files either through Send or Exchange:

1 Display the Connections menu.
2 Choose the remote user's name under Disconnect All Users.
3 The file transfer is stopped. The file that was in the process of being transferred is not copied, but all 

previously transferred files remain on the disk to which they were copied.
4 If you want to restrict other users' ability to connect to your PC, you can control individual user access 

in the Security dialog box.

Adding new registered users 
Changing the user access privileges



Selecting Multiple Items in a File List
To select consecutive files and/or folders:
Click the first item, hold down the Shift key, and click the last item.

To select nonconsecutive files and/or folders:
Click the first item, hold down the Ctrl key, and click the remaining items.



 Remote control
The subtopics under Remote Control:

Control another user’s computer 
Observe another user’s desktop 



 Control another user's computer
You can control a remote computer running Timbuktu Pro. The desktop activity of the remote computer is 
displayed in a window on your screen. This window is updated as the remote computer's desktop 
changes. 
The Control window displays a real-time view of the desktop of the Timbuktu Pro computer shown in the 
title bar.    You can view hidden parts of the desktop by moving your pointer toward the edge of the window
or by clicking in the scroll bars.    Any of the mouse movements you make or keys you press (excluding 
function keys) will be carried out on the computer you are connected to.
While controlling another computer, you can perform any of the tasks that you could perform locally, 
including opening applications and creating new files. This means that a user with the Control permission 
can remotely create, modify, or delete files without restriction, and can erase data from another 
computer's disk. This permission, therefore, should be granted with caution.
If the remote computer’s screen resolution is higher than yours and you can maximize your Control 
window, the AutoScroll feature is enabled so that you can view the entire remote desktop.

To control another computer:
1 Select or specify the address of the machine you want to control.
2 Click Control from the Services menu.
3 To connect to the desired remote computer, you may be asked to log in. Timbuktu Pro displays the 

other computer's desktop in a screen-sharing window.

Note: If a screen-sharing window doesn't open, it may mean the Control service is not granted to the 
registered user account on the remote computer.

4 While this window is active you can use your mouse and keyboard to operate the remote computer.
5 Clicking in a screen-sharing window makes it the active window. To return to your own computer, click 

outside the screen-sharing window.
To stop controlling, choose Close from the system menu of the screen-sharing window or click its Close 
button. Timbuktu Pro closes the window and ends the connection.

Note: If a remote user is controlling your screen while Timbuktu Pro is minimized, the regular Timbuktu 
Pro icon in the system tray on the task bar is replaced with an icon that alternates between the regular 



Timbuktu Pro icon and an icon that shows you have a connected remote user.

If you want to enable or disable the Control service on your Timbuktu Pro computer, you can do so in the 
Security window by specifying Observe/Control service for guests and registered users.

While controlling a remote computer, you can start another service with the same user. Click the system 
menu to start other services like Send, Exchange, Notify, Chat, and Intercom.

To control more than one computer at the same time:
1 Select or specify the address of the machine you want to control.
2 Choose Control from the Services menu
3 To connect to the desired remote computer, you may be asked to log in. Timbuktu Pro displays the 

other computer's desktop in a screen-sharing window.
4 Repeat steps 1 to 3 for additional computers.



 Observe another user's desktop
You can observe a computer running Timbuktu Pro. The desktop activity of the remote computer is 
displayed in a window on your screen. This window is updated as the other computer's desktop changes.
While observing another computer, you can see the activity on its screen, but you cannot control any of its
actions. This privilege is useful for diagnosing problems on another computer.
If the remote computer’s screen resolution is higher than yours and you can maximize your Observe 
window, the AutoScroll feature is enabled so that you can view the entire remote desktop.

To observe another user’s desktop:
1 Select or specify the address of the machine you want to observe.
2 Click Observe from the Services menu.
3 To connect to the desired remote computer, you may be asked to log in. Timbuktu Pro displays the 

other computer's desktop in a screen-sharing window.

4 Clicking in a screen-sharing window makes it the active window. To return to your own computer, 
click outside the screen-sharing window.
5 To stop observing, choose Close from the system menu of the screen-sharing window or click its 
Close button. Timbuktu Pro closes the window and ends the connection.

If a screen-sharing window doesn't open, it may mean that the Observe service is not granted to the 
registered user account on the remote computer.

Note: If a user is observing your screen while Timbuktu Pro is minimized, the regular Timbuktu Pro icon is
replaced with an icon that alternates between the regular Timbuktu Pro icon and an icon that shows you 
have a user.

If you want to enable or disable the Observe service on your Timbuktu Pro, you can do so in the Security 
window by specifying Observe service for the guest and the registered users.

While observing a remote computer, you can start another service with the same user. Click the Observe 
system menu to start other services like Send, Exchange, Notify, Chat, and Intercom.

To observe more than one computer at the same time:
1 Select or specify the address of the machine you want to observe.



2 Choose Observe from the Services menu
3 To connect to the desired remote computer, you may be asked to log in. Timbuktu Pro displays the 

other computer's desktop in a screen-sharing window.
4 Repeat steps 1 to 3 for additional computers.



 Displaying the logon dialog box of a Windows NT 
computer
If you're connecting to a computer that is running Windows NT, you'll need to know how to get to the 
Window NT logon dialog box over the Timbuktu Pro connection. It's not possible to do this simply by 
pressing the Ctrl+Alt+Del keys on your computer. You'll need to follow the steps below.
To cause the Windows NT system to display its logon dialog box:

1 Control the Windows NT computer.
2 Click the system-menu button, in the upper left corner of the screen-sharing window:

3 Choose the Send Ctrl+Alt+Del to Remote Computer option. The logon dialog box is displayed, 
allowing you to enter your account name and password.

Note: You don't have to log on to Windows NT to use Timbuktu Pro with a Windows NT computer.    In 
addition to controlling the computer before logging on, you can also exchange files with, and send files to,
a Windows NT system. Be aware, however, that FlashNote icons (or windows) are not displayed on the 
Windows NT system until after you have logged on.



 Screen Blanking
Screen blanking prevents anyone from viewing the remote computer’s screen and what is happening on 
the remote computer that is being controlled. When the host's screen is blanked, it will remain frozen with 
the "Workstation Locked", (blank black screen) or "Begin Logon" dialog boxes displayed. This initial 
condition of the host's screen won't change until the remote guest has disconnected.

The remote user will not be able to see what you are doing on the desktop, but the remote user may be 
able to see the cursor move and hear any audio that your computer may generate.



 Personal Communications
Requesting Notification when a remote user is active 
Chat with a Remote User 
Speak to a Remote User 



Requesting Notification when a remote user is 
active
The Notify service lets you leave an electronic request to be notified when a remote user has started 
using his or her computer. This is a useful indicator to find out if the person you want to communicate with
is available. You can then call or begin a Chat, or Intercom session with the remote user. 

To request notification:
1 Select the remote address. 
2 Click the Notify Service button. You may be asked to log in.
3 The Notifying <machine name> dialog appears, telling you that Timbuktu Pro is waiting for an answer

from the remote computer.

The items in this dialog are as follows:
Last Active tells you the date and time the remote user last moved the mouse or pressed a key. This 
field changes to Became Active the next time the remote user moves the mouse or presses a key 
and displays the new date and time.
Idle Time tells you how much time has passed since the remote user has used his or her computer.
Message displays the text, that was entered in the Preferences dialog Notify tab.

4 While you're waiting, you can work on tasks in other windows. If you don't want the Notify window 
cluttering up your desktop, click its Minimize button, but don't close the window. 

On the remote computer, a dialog box tells the remote user that you are asking to be notified.

Note: The remote user may choose to disable the last active and idle time message fields.

5 If the remote user clicks the Acknowledge button in the above dialog, the message in your Notify 
window changes and displays a message: “<username> is there”.



Note: If you have minimized the Notify window, it is maximized automatically. The remote user also has 
the option of clicking the Notify Again, Chat, or Intercom button.

6 You can now close the Notify window and call the remote user, or you can use either of the additional 
buttons that are now displayed: Notify Again, Chat, or Intercom.

n If the Notify window was reactivated while you were away from your computer, the remote user may 
no longer be at their computer by the time you get back. You can start the notification process again 
by clicking the Notify Again button and returning to step 3.

n If you want to initiate a keyboard conversation or voice communication with the remote user, click the 
Chat or Intercom button, respectively. 



 Chat with a Remote User
The Chat service lets Timbuktu Pro users post messages to one another interactively. For example, if you
are already in the midst of a file transfer session, a Chat window lets you tell the remote user which file is 
being transferred.

To chat with a remote user:
1 Select the remote address
2 Choose Chat from the Services menu. You may be asked to log in.
3 When the Chat window is displayed, type your first message and click the Send button or press 
Enter.

Note: To move your message text to a new line, you need to insert a carriage return in your message. 
To insert a carriage return, press Ctrl+Enter.

4 Your message is copied to the transcript panel in the upper part of the window. You can type more
messages immediately or wait for a reply from the remote user. The reply is displayed below your 
message in the transcript panel. You can keep typing messages back and forth as long as you like.

5 When you've finished chatting, click the Disconnect button. When either party disconnects, the session
is ended, and the status at the bottom of the window changes to Disconnected.

Printing the Chat Session
Click Print to print the chat-session details. This displays the Print dialog box, where you can specify the 
default printer and printer options.

Saving the Chat Session
Click Save to save the chat-session details to a text file. This displays the Save dialog box, where the 
user can specify the destination filename and folder.

Note: You can Chat with more than one other user at the same time, but you'll need to open a separate 
Chat window for each additional participant.

Chatting with a Macintosh user



 Chatting with a Macintosh user
When you connect to a Macintosh for a Chat session, the Chat window works the same as it does when 
you connect to a Windows computer.

Timbuktu Pro for Macintosh users can also initiate Chat sessions with Timbuktu Pro computers. Unlike 
Timbuktu Pro for Windows, Timbuktu Pro for Macintosh can have any number of participants in the same 
Chat session. Therefore, don't be surprised if you see additional names displayed in the Chat transcript 
window when you're chatting with a Macintosh user.



Speak to a Remote User
The Intercom service lets remote users talk to each other through their computers.

View system requirements

To speak to a remote user:
1 Select the remote address.
2 Choose Intercom from the Services menu or click the Intercom icon on the connection bar. You may 

be asked to log in.

Note: If the sound card on your computer or the one you are connected to is already being used by 
another application, you won't be able to begin your Intercom session until the other application has 
been closed.

3 When the Intercom window is displayed, you can begin speaking with the remote user, provided your 
computer meets the specified hardware requirements.

Note: The Intercom window does not automatically stay on top of the screen when other application 
windows are running in the foreground.

6 When you've finished talking, click the Close button.

Adjusting your microphone and speaker levels



System Requirements for Intercom Service
Both participants in an Intercom session will need to have:

n At least a 486 DX2 66MHz processor
n An operating system supported sound card
n Speaker(s)
n A microphone



Adjusting your microphone and speaker levels
To raise or lower the speaker volume of your computer:
Drag the Speaker volume slider toward "High" to increase the volume and toward "Low" to decrease the 
volume.

Note: If the level indicator lights next to the speaker icon are flashing but you can't hear anything, it 
means that Timbuktu Pro is receiving transmissions from the remote user, but your speakers are either 
switched off or the speaker volume is set too low.

To raise or lower the talking threshold of your microphones:
If the Intercom status doesn't switch from "Idle" to "Transmitting" when you start to talk, drag the Talking 
Threshold slider toward "Low."    If Intercom starts transmitting from your computer because the 
microphone is picking up noise from your office, drag the slider toward "High."

Speaking into the microphone should cause all five green lights located next to the microphone icon to 
flash. It's also OK for one or two of the red lights to flash occasionally.

If all eight indicator lights are flashing constantly, your Talking Threshold is set too high:

Drag the slider toward "High" to lower the Talking Threshold.

Note: If you want to switch off your microphone temporarily, click the Mute Mike checkbox.

To configure the Intercom service for headphones or a handset:
If you and the other user both have full-duplex sound cards, you may want to use headphones or a 
handset to avoid the feedback loop that occurs when the sound from your speaker is picked up by your 
microphone.

Select the Using Headphones or Handset (Full Duplex) option. 
Note: If the option is dimmed, your computer is not using a full-duplex sound card.

Selecting the right compression for your situation:
The Sound Compression pop-up menu lets you optimize the Intercom service according to the equipment
you are using.

n The higher the compression, the smaller the bandwidth that is required from your network or modem. 
This is important for 14,400 Baud modems or slower.

n The lower the compression, the better the sound quality and the lighter the work that is required by 
your CPU. This is important for people using 486 CPUs.

The table below contains suggested settings for the Sound Compression option under various hardware 
combinations. However, experimentation is your best guide.

Sound Compression Settings
Transport Type: LAN or 28.8-33.6



ISDN line modem

CPU:
486 None

needed

Pentium None
needed

Compression
needed

Intercom with 
screen sharing 
(Pentium 
required)

None
needed



  Security
Timbuktu Pro has a flexible security framework. You can customize Timbuktu Pro remote user access 
restrictions to your personal comfort level as well as to the needs of your organization through the 
Security window. 

The topics listed below provide information on the various ways in which you can tailor your user 
privileges.

Remote users—Timbuktu Pro users on Windows or Macintosh computers—can access your computer as
Guests, Registered Users or Windows NT Users.

n Guests, can access your computer without asking your permission and without typing a password.
Granting a service to guest users 
Grant a service to all guests 
Allowing unrestricted guest access
Remove a service from user access 

n Registered users, can access your computer by typing the correct remote user name and password.
Adding new registered users 
Changing a registered user account 
Removing registered users 

n Ask For Permission guests, must wait for you to click OK before they can access your computer.
Grant a service to Ask For Permission users 
Admit an Ask For Permission guest 

n Temporary guests who must wait for you to click OK.
Admitting a temporary guest 

n Windows NT Users, can access your computer from a Windows NT system.    

It's up to you to designate which services—Send, Exchange, Observe, Control, Notify, Chat, and Intercom
—will be available to any of these kinds of remote users.



Note:
n Ask For Permission users and Temporary guests require you to be at your computer for a remote 

session to begin.
n Any service granted to guests is available to registered users and Windows NT Users.
n Registered users are allowed to change their passwords after their initial log in, but they cannot 

change their user names or the services that you have granted to their accounts.

Monitoring past connections
Timbuktu Pro's System menu displays the names of all users who have recently connected to your 
computer and indicates which services were used. You can also display (and save as a text file) an 
activity log of previous connections.    The log can preserve up to 32K of activity information before it 
begins to discard its oldest records.
Checking for users
Disconnecting a remote user 
Keeping users out
Clearing Previous Users
Checking the Activity Log

Other subtopics under Security:
Changing your user password
Logging on
Setting your master password



 Setting your preferences 
Changing your General options
Changing your Control/Observe options
Changing your Send options
Changing your Notify options
Changing your Master Password



 Remote users
Guests or Ask for Temporary Permission guests do not require a password to make a connection. 
Guests can use any service if the Timbuktu Pro remote user has granted them permission to use.

Granting a service to guest users 
Grant a service to all guests 
Allowing unrestricted guest access
Remove a service from user access 

Each registered user must be defined by a name, a password, and one or more service access 
permissions. You can grant specific service permissions to the selected user.

Adding new registered users 
Changing a registered user account 
Removing registered users 

Privileges you define for Guest users are automatically granted to all registered users as well. For 
example, if you grant the Send privilege to a Guest user, you cannot deny this privilege to registered 
users.

Each Windows NT User is defined by the existing Windows NT username.    You can grant or remove 
specific permissions to the Windows NT users or Windows NT groups. You cannot create, modify, or 
destroy the Windows NT user accounts or Windows NT groups.

Granting Windows NT Users or Windows NT Groups Access Permissions
Removing Windows NT Users or Windows NT Groups Access Permissions



 Granting services to guest users
To grant a service to guest users:

1 Choose Security from the Setup menu.
2 Click the Guests tab. This option is selected by default.
3 Choose the services you want to grant the guest users.
4 Click OK to save the new Guest service access permissions.



 Grant a service to all guests
When you grant a service—for example, Send or Chat—to all guests, any remote user can use that 
service with your computer whenever your Timbuktu Pro is open.
Remember to exercise caution when granting a service to all guests. The guest doesn't have to type a 
password to use the service with your computer, nor are you prompted to give permission before the 
guest's session begins.
Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drive that you are currently logged into.
DO NOT grant Exchange privileges if your computer contains sensitive, or confidential information.

To grant a service to all guests:
1 Display the Timbuktu Pro window.
2 Choose Security from the Connections menu.
3 Make sure the service you wish to grant to all guests is selected in the Guests tab.
4 Click OK to close the Security window.



 Allowing unrestricted guest access
Caution: This procedure grants all service permissions, including deleting files, to any Timbuktu Pro 
guest on the network without password protection. Do not proceed if you have sensitive or confidential 
information on your computer.

To allow all Timbuktu guests unrestricted access to your computer:
1 Choose Security from the Setup menu.
2 Select the Guests tab. This option is selected by default.
3 Select all the services.
4 Click OK to save the new Guest service access permissions.



 Remove a service from user access
If you decide that a certain service should not be available to your remote users, you must remove that 
service from Guests, Registered Users, Windows NT users and Ask For Permission guests. The following
procedure takes you through the kinds of remote user status to make sure the service has been removed 
from each of them.

To remove a service from remote user access:
1 Select Security from the Setup menu.
2 Click the Guests tab.
3 If the service you want to remove is selected in this tab, deselect it.

Note: To prevent remote users from even asking for permission to use the service, you'll also need to 
deselect Users may ask for permission to use unchecked services.    However, doing this may lock out 
services that you want to keep available for Ask For Permission users.

4 Click the Registered Users tab and repeat the following procedure for each name in your registered 
user list:

Select the registered user name. If the service you want to remove is selected in the list of services 
granted to that registered user, deselect it.

5 Click OK to close the Security window.



 Adding new registered users
Each registered user account is defined by name, password, and one or more services.

To add a registered user account:
1 Choose Security from the Setup menu.
2 Click the Registered Users tab.

3 Click Add Registered User. Timbuktu Pro adds a registered user entry called New User.
4 In the Name field, type in the user name that the registered user must use to connect to your 
computer.
5 Press Tab to move to the Password field.
6 Type in the password that the registered user must have in order to connect to your computer.

Note: During the log-in procedure, the registered user is free to change the password as long as the 
replacement password conforms to any password restrictions you set. Passwords are case sensitive.

7 Press Tab to move to the Confirm field.
8 Retype the password exactly as you typed it before.
9 Press Tab to move to the Check the services to grant panel.
10 Select the service(s) you wish to grant to this registered user.

Note: Services granted in the Guest tab are automatically granted to all registered users as well. For 
example, if you grant the Observe service to guest users, you cannot deny this service to your 
registered users. It will be dimmed in the Registered user tab.

11 If desired, click the Password Restrictions to enforce certain password restrictions on the registered 
users connecting to your computer. For more information, see Setting password restrictions for 
registered users .

12Define additional registered user accounts, if desired, by repeating steps 2-10.
13Click OK to save the new entries and close the dialog box.





 Changing a registered user account
To change a registered user account:

1 Choose Security from the Setup menu.
2 Click the Registered Users tab.
3 Select the registered users from the list on the left side of the dialog box.
4 To change the name or password, select it, then type the new value. If you change the password, you 

will have to type it again in the Confirm field.
5 To change a service, click its check box.
6 Click OK to save your changes and close the dialog box.



 Removing registered users
To remove a registered user:

1 Choose Security from the Setup menu.
2 Click the Registered Users tab.
3 Select the user from the list on the left side of the dialog box.
4 Click the Remove Registered User button in the dialog box.
5 Click OK.



 Setting password restrictions for registered users
Whenever a registered user logs on to your computer, he or she can change the password without your 
permission.
However, registered user are not necessarily free to type in any new passwords they please. You can 
impose the following limitations on the kinds of passwords that your Timbuktu Pro will accept.

To set password restrictions on registered user accounts:
1 Click Security from the Setup menu.
2 Select the Registered Users tab.
3 In the Registered Users tab, click Password Restrictions.

You can select any combination of the requirements listed below to impose limitations on how your 
registered user can modify their passwords:
Passwords can't match the three previous passwords.

When this option is selected, Timbuktu Pro rejects any new password that matches any of the 
remote user's previous three passwords. The remote user must enter a valid password or cancel 
the Change Password dialog box.

Minimum number of characters in passwords.
Enter a number in the field to define a minimum password length. When this option is selected, 
Timbuktu Pro rejects any new password that is shorter than the specified length.

Number of days until password expires.
Enter a number in the field to define the number of days each new password is to remain valid. 
When this option is selected, the user will be asked to create a new password, after the specified 
number of days have passed, before he or she can use any Timbuktu Pro services on your 
computer.

Note: These restrictions do not apply to setting your own master password.



 Windows NT Users
Timbuktu Pro uses the Windows NT user account lists when it is installed on an Windows NT server or 
workstation.    The NT Users tab of the security dialog appears only when the following conditions are met,
otherwise the tab is not visible.

n The local operating system is Windows NT 4.0 or later.    Both server and workstation are supported.
n The account that Timbuktu Pro is running under has privileges to read user/group settings from the 

operating system
n The account that Timbuktu Pro is running under has write access to the registry tree limb.

Using the NT Users tab of the Security dialog you can assign Timbuktu Pro privileges to Windows NT 
users and groups.

To assign Timbuktu Pro privileges to Windows NT users:
1 Choose Security from the Setup menu.
2 Click the NT Users tab.

3 To view the services granted to a user or group, select the user or group. The services granted 
appear checked in the Check services to grant panel.

You can grant services to NT users by checking against the service in the Check services to grant panel.

4 Choose Add. The Add Users and Groups dialog appears.



5 Choose Remove to remove the highlighted names from the list.

Note: You can only select existing users and groups for use by Timbuktu Pro. You cannot create new 
Windows NT users or groups.

6 Choose Members to view the local group membership. The Local Group Membership dialog appears. 
This displays the members of the group.



 Grant a service to Ask For Permission users
When you grant a service to Ask For Permission guests, each time a remote user wants to use that 
service with your computer, you must be at your computer to give permission by clicking OK in the Ask 
For Permission dialog box.

To grant a service to Ask For Permission users:
1 Display the Timbuktu Pro window.
2 Choose Security from the Setup menu. The Guests tab is displayed.
3 If the service you wish to grant to Ask For Permission users is selected in this tab, deselect it.
4 Make sure the Guests may ask for permission to use unchecked services option is selected.
5 Click OK to close the Security window.



Admit an Ask For Permission guest
Most users will connect to your Timbuktu Pro computer by asking for your permission. You have to be 
at your computer to let them in.

To admit an Ask For Permission user:
1 Select the Security option in the Setup menu, then check the Guest tab to make sure the Users may 

ask for permission to use unchecked services option is selected.    Ask For Permission applies only to 
unselected services. Click OK to close the Security dialog box.

2 When the remote user connects to your computer, the login dialog appears.

3 The remote user must click on Ask for permission.
4 When a remote user is waiting to connect to your Timbuktu Pro desktop with an Ask For 
Permission service, a dialog box appears on your computer that says "The following user is waiting for 
admittance." The user’s name, IP address, and requested service appear below this message.

5 Click OK to allow the connection or click Cancel to reject it.



 Admitting a temporary guest
The Admit Temporary Guest command allows you to grant attended access to Timbuktu Pro 1.x users
who can not ask for permission.

To admit a temporary guest:
1 Arrange an appointment with the user that wants to connect to your computer.
2 At the appointed time, choose Admit Temporary Guest from the Connections menu.

3 When the guest user connects to your PC, the guest's Timbuktu name and IP address is 
displayed in the Admit Temporary Guest dialog box along with the privilege the temporary guest has 
selected.
4 Click OK to begin the attended access session.



 Check for remote users
If a remote user has logged in to your computer, the Timbuktu Pro icon in the system tray in your 

taskbar alternates between the Timbuktu Pro application icon  and a service icon that shows the 
service being used by the remote user.

User
Icon

Meaning

    A remote user    is using the Send service with your computer.

    A remote user is using the Exchange service with your computer.

    A remote user is using the Observe service with your computer.

    A remote user is using the Control service with your computer.

    A remote user is using the Chat service with your computer.

    A remote user is using the Intercom service with your computer.

    A remote user is using the Notify service with your computer.

The remote user icon appears next to the clock at the right end of the taskbar. Right-click the remote user 
icon to display a list of current remote users and the services they are using.



 Disconnecting a remote user
To disconnect a remote user session:

1 Select the Connections menu.
2 Choose a name from the list of remote users listed below Disconnect All Users. You can also 

disconnect all users by choosing Disconnect All Users.

Note: You can also disconnect all of the users when Timbuktu Pro is minimized by right clicking on the
Timbuktu Pro icon in the system tray of the taskbar and selecting Disconnect All Users from the 
system menu.



 Keeping users out
To prevent anyone from connecting to your computer, you need to Shut Down the Timbuktu Pro 
application. This locks remote users out and also prevents you from connecting to other computers. 

Note: If you Exit Timbuktu Pro without a shut down, it does not lock remote users out of your 
computer.



 Clearing Previous Users
Previous users are users who were once connected to your PC but either have completed their tasks 
or have been disconnected by you. The user list consists of names of such previous users. For that 
reason, the names are dimmed in the Connections menu, and you can remove them as explained in 
the following procedure.

To clear the list of previous users:
1 Choose Clear Previous User List from Connections menu or the taskbar menu. The names that are 

listed below the command are deleted.

Note: You can also clear the previous user list when Timbuktu Pro is minimized by clicking on the 
Timbuktu Pro icon and selecting Clear Previous User List from the System menu.



 Check the Activity Log
The activity log contains a list of the Timbuktu Pro tasks users have performed on your PC and your 
tasks. This list can be useful as a record of file transfers from users, and can be used to help 
diagnose problems you encounter when using the application. 

Each line of the activity log contains the following:

n A date, in the form of mm/dd/yy
n A time, in the form of hh:mm:ss AM/PM
n The service of Timbuktu Pro that was affected
n The activity that was carried out—for example, the Timbuktu Pro application was launched, or you 

opened your Timbuktu Pro.
n The Timbuktu Pro computer name that caused the activity

To view and save the activity log:
1 Choose Activity Log from the Connections menu. The Activity Log window appears.
2 If you'd like a copy of the log, verify that your computer has at least 32K of available disk space, then 

click Save As, type a name for the log, and select the destination folder.

The log also reports when Timbuktu Pro was loaded, when Previous Users were cleared from the 
Connection menu, and when Timbuktu Pro was shut down.

To edit or print the activity log:
3 To edit or print your activity log, first click Save As and save the log as a text document. This can be 

opened and printed by a word processing application such as Notepad, or imported into a spreadsheet
or database document

4 Click OK.

Note: The activity log can preserve up to 32K of activity information before it begins to discard its 
oldest records.



 Windows NT Event Logging
On Windows NT, Timbuktu Pro also logs guest and host service events to the Windows NT Application 
Event Log. 

To see these events in the Application Log, go to Start>Programs>Administrative Tools>Event View and 
choose Application under the Log menu.



 Logging on
You can connect to a remote computer either as a guest, as an Ask for Permission guest, a registered 
user, or a Windows NT user.

n When you connect to another computer as a guest, or a Windows NT user you are granted immediate 
access to the remote computer via the service you select. No additional steps are necessary.

The Login dialog box is displayed for one of two reasons:

n When you connect to another computer as an Ask for Permission guest, you have to wait until the user
of the remote computer allows you to connect. A dialog box appears, indicating that you are waiting for
the user of the remote computer to allow you to connect.

n When you connect to another computer as a registered user, you must go through a log-on procedure.

Log on as a registered user 
Log on to ask permission 
Changing your user password 



 Log on as a registered user
To log on to another computer as a registered user:

1 Connect to a remote computer using one of Timbuktu Pro's services. If you have been assigned a 
password on the remote computer, the Log On dialog box appears.

2 Your Timbuktu Pro user name is entered in the Name field automatically. If necessary, type a different 
name in the Name field.

3 Press the Tab key.
4 Type your password in the Password field.
5 Click OK.
6 If your credentials are verified, you are allowed to connect to the remote computer. Click Cancel if you 

want to cancel your connection attempt.

Changing your user password



 Log on to ask permission
If you are asking for permission:

1 Connect to a remote computer using one of Timbuktu Pro’s services. If that service is available to Ask 
for Permission guests, the Log On dialog box appears

2 Select the Ask for Permission option
3 Click OK. The Waiting for admittance dialog appears
4 If the remote computer admits you, you are allowed to connect to the remote computer. Click Cancel if

you want to cancel the connection attempt.

n Note: The Waiting for Admittance dialog will close if the remote user does not respond in 30 seconds.



 Changing your user password
To change your user password:

1 When the Log On dialog box is displayed, type a name in the name field and click the Set Password 
button. The Change Password dialog box will appear.
Logging on 

2 Type your current password in the Old Password field.
3 Type your new password in the New Password field.
4 Type the new password again in the Confirm field.
5 Click OK.

Note: The    Timbuktu Pro remote user may have placed restrictions on the kinds of passwords that he
or she allows. Your new password must meet these requirements.

Setting password requirements for registered users



 Connection tabs
There are 3 Default tabs: Address Books, Recent Connections, and TCP/IP.

                                  Icons for the Tabs

Click on the tabs to move between them or use the keyboard shortcut commands. Press CTRL + Tab to 
move between the Connection tabs.

Address Books
Recent Connections
TCP/IP



 Address Books
The Address Books tab is used to store and group Timbuktu Pro addresses. 

You can add or delete addresses. Each address has a default service, computer name, address    
and description. The description field in the address book entry can be changed.

Note: If a remote address appears in an address book, it does not guarantee that the user at that 
address is currently running Timbuktu Pro. If Timbuktu Pro is not running on the remote computer, you
will not be able to set up the connection.

Some TCP/IP addresses may change (dynamic addresses). They can be automatically re-assigned 
to computers other than the ones appearing in your address books. If your organization uses dynamic
TCP/IP addressing, you may not want to store the IP address in Timbuktu Pro’s address book.
 

1 Select the Address Books tab. 
2 The items on this tab are:

n Book Dropdown list—Click the dropdown list to display all the open address books. Select an address 
book from the drop-down list. You cannot type anything in the Address Book field. Selecting an item 
from the drop-down list will make it the current book.    The contents of the current book are shown in 
the Address List box.

n List View button—Click this button  to display the items in the Address List box in List view mode. 
In List view mode, only the default service icon and the Computer Name are shown.

n Detail View button—Click this button  to display the items in the Address List box in Detail view 
mode. In Detail view mode, it shows the Default Service, Computer Name, Address, and 
Description.
Selecting items in the Address List Box 
Selecting a Sort Criteria 

n Add New Address button—Click this button  to add an address to the address book.

n Properties button—Click this button  to display a Properties dialog for the selected address. 
This button is enabled only when a single address is selected. 



 It is disabled if either no address is selected, or multiple addresses are selected.

n Create Desktop Shortcut button—Click this button  to create a Timbuktu Connection document 
(TMB extension) on the Windows desktop. This button is enabled when either a single address is 
selected, or multiple addresses are selected.    It is disabled if no address is selected. 

n Delete Address button—Click this button  to delete the selected addresses. When the user 
deletes an item in the Address Books or Recent Connections tab, a confirmation dialog appears. The 
delete button is enabled when either a single address is selected, or multiple addresses are selected.    It 
is disabled if no address is selected. 

Note: If you move the mouse over the buttons a Tool Tip will pop up identifying the button.

n Address List box—This shows the contents of the current Address book. The listing can be in List view
mode or Detail view mode. 

n Item Count panel—This displays the number of addresses in the current address book.    It refreshes 
when addresses are added or deleted.

Left click once on an address to change the name. Right click once on the selected item displayed in the 
right-click Timbuktu Pro menu.

n Select Timbuktu Pro option to access any of the Timbuktu services. If multiple addresses are selected 
then the service is invoked once for each address.

n Select Copy To option to move selected addresses into an address book or to create a new address 
book.    You can select the destination address book from the dialog that displays a list of address 
books. Select New address book to create a    new address book. 

Opening Address Books
Closing Address Books
Adding addresses
Deleting addresses



 Selecting a Sort Criteria
To choose a sort criteria:

1 When in Detail mode, you can sort by clicking on the Detail headers for Service, Computer Name, 
Address, and Description. Clicking Computer Name the first time sorts in ascending order. Clicking 
Computer name again sorts in descending order. This applies to the other headers as well.

2 When in either the Detail view mode or List view mode, you can sort using menu items.    This 
View menu is enabled only when you have selected either the Address Books tab or the Recent 
Connections tab. It is disabled when you have selected the TCP/IP tab.



 Selecting items in the Address List Box
You can select items in the Address list box using the mouse or the keyboard.

Mouse Selection:
1 Select single items by clicking the item once. The selected item is highlighted.

                                                              Single Selection Example

2 To select consecutive multiple items click the first item, hold down the shift key, and click the last 
item.

                                                            Multiple Selection Example

3 To select random multiple items, hold down the Ctrl key and click on the items.

Keyboard Selection:
1 Select individual items by using the arrow keys up, down, left, and right.
2 Select consecutive multiple items by using the arrow keys to highlight the first item, hold down    the 

shift key, and use the arrow keys to highlight the last item.

Select multiple items by using the arrow keys to highlight the first item, hold down the Ctrl key, and, 
use the arrow keys to highlight each item. Press the spacebar to select the item.



 Opening Address Books
To open an address book:

1 Choose Open Address Book from the File menu. The Open File window is displayed.
2 Open a file with an address book extension (.tbk). This address book is added to the drop down list 

of currently opened address books in the Address Books tab.



 Closing Address Books
To close an address book:

1 Click the Address Books tab.
2 Select the address book you wish to close from the drop-down list.
3 Select Close Address Book from the File Menu.

Note:    If you have only one address book open you are not allowed to close it.



 Adding addresses
You can add addresses from the TCP/IP tab to the selected address book.

To add an address to the address book:
1 Click the TCP/IP tab and type the IP name or IP address. 
2 Click the Add New Address button.

Timbuktu Pro attempts to contact the chosen computer to verify information and fill in the fields of this 
dialog box. This may take a few seconds. If the remote computer isn't available, Timbuktu Pro displays
default information.

3 Click OK to complete the procedure.

To add an address to the address book using the Recent Connections tab:
1 Click the Recent Connections tab. 
2 Select from the address list.
3 Click the Add New Address button.
4 Select the destination address book.
5 Click OK to complete the procedure.



 Deleting addresses
You can remove addresses from the selected address book, in the Address Books tab.

To delete an address from the address book:
1 Select the Address Books tab.
2 Select an address book from the pulldown menu. This drop-down list contains the list of open address 

books. The addresses from the selected address book appear in the window.
3 Select one or more addresses that you wish to delete from the window.
4 Press the Delete key from the keyboard.
5 Click OK to confirm.



 Recent Connections
The Recent Connections tab lists the computer that either you are connected to, or which has connected 
to you. The default service is the same as the service that was used when the entry was created. You can
specify the number of entries to be maintained in the General options.
Customize Timbuktu Pro's General preferences 

Adding to the Recent Connections Address List Box.

The Recent Connections tab automatically stores the Timbuktu Pro addresses of:

n Incoming guests who connect to your computer.    For example, if Jim’s W95 portable controlled your 
PC, Jim’s W95 portable’s address will be added to your Recent Connections Address list box. The 
default service will be Control, because that’s the service type used.

n Your outgoing connections. For example, if you sent a FlashNote to Jim’s Alpha NT server, Jim’s NT 
server’s address will be added to your Recent Connections Address list box. The default service will 
be Send, because that’s the service type used.

1 Click the Recent Connections tab.
2 The items on this tab are:
n List View button—Click this button  to display the items in the Address List box in List view mode. 

In List view mode, only the icon and the Computer Name are shown.

n Detail View button—Click this button  to display the items in the Address List box in Detail view 
mode. In Detail view mode, it shows the Default Service, Computer Name, Address, and 
Description.

n Add New Address button—Click this button  to add an address to the address book.

n Properties button—Click this button  to display a Properties dialog for the selected address. 
This button is enabled only when a single address is selected. It is disabled if either no address is 
selected, or multiple addresses are selected.

n Create Desktop Shortcut button—Click this button  to create a Timbuktu Connection document 
(TMB extension) on the Windows desktop. This button is enabled when either a single address, is 
selected, or multiple addresses are selected. It is disabled if no address is selected. 

n Delete Address button—Click this button  to delete the selected addresses. When the user 
deletes an item in the Address Books or Recent Connections tab, a confirmation dialog appears. The 
delete button is enabled when either a single address is selected, or multiple addresses are selected.    It 
is disabled if no address is selected. 

n Address List box—This shows the contents of the current Address book. The listing can be in List view
mode or Detail view mode. In List view mode, only the icon and the Computer Name are shown. In 
Detail view mode, it shows the Default service, Computer Name, Address, and Description.

n Item Count panel—This displays the number of addresses in the current address book.    It refreshes 



when addresses are added or deleted.

Note:  If you move the mouse over the buttons a Tool Tip will pop up identifying the button.



 TCP/IP
The TCP/IP tab lets you type in the IP name or IP address of a remote computer on a TCP/IP network. 
The drop down combo field has the last several addresses that were entered in most recent first order.    
The number of addresses to keep is specified in the General Preferences.
Customize Timbuktu Pro's General preferences 

1 Click the TCP/IP tab.
2 Type in the name or address of the remote computer you wish to connect to and select the Timbuktu 

Pro service that you wish to use.

Since you cannot browse a TCP/IP network, you will want to save the frequently used TCP/IP 
addresses in an address book for more convenient access.

Address Books 

TCP/IP information 



 Menus 
Click the desired menu option to learn what it does.

See Also
Taskbar Support 



 Taskbar Support
Timbuktu Pro features can be accessed from the icon on the taskbar in the system tray of the toolbar. For 
example, if you select a 'Current User' entry then that user will be disconnected from your system.



Open Address Book
Displays the Open File window, in which the user can open a file with an address book extension. This 
address book is added to the drop down list of currently opened address books in the Address Books tab.



Close Address Book
Displays the Close File window, in which the user can remove the current address book from the drop 
down list of currently opened address books.



Properties
Displays the properties of the selected user address. Properties include default service, computer 
name, address and description.



Delete
Allows the user to delete a single address or a group selection of addresses.



Exit
Closes the Timbuktu Pro main window and minimizes Timbuktu Pro to an icon on the taskbar in the 
system tray of the toolbar. Users can still access your computer. To switch off Timbuktu Pro completely, 
choose Exit and Shut Down Timbuktu Pro.



Exit and Shut Down Timbuktu Pro
Switches off Timbuktu Pro completely. No user can access your computer after you exit and shut down 
Timbuktu Pro and you can no longer connect to remote computers.



#Edit menu



Cut
Allows the user to cut an address or a group selection of addresses from an address book.



Copy
Allows the user to copy an address or a group selection of addresses from an address book.



Paste
Allows the user to paste an address or a group selection of addresses to an address book.



Rename
Allows the user to rename a single address.



Copy To
Allows the user to copy addresses to address books.



Create Shortcut on desktop
Allows the user to create Timbuktu Shortcut Connection Documents on the desktop for the selected 
address or addresses.    Uses the Description field for the document name and default to a control session
unless the address has a default service value.



#Setup menu



Security
Displays the Security window, in which you can add, change, and removes registered users and Windows
NT users. You can also designate which services are available to guest users or with ask for permission 
users.



Preferences
Displays the Preferences window, in which you can change the settings for the Control/Observe, Send, 
and Notify services. You can also specify a master password, and whether the Timbuktu Pro application 
should launch automatically when Windows starts.



#Services menu



Send
Displays the FlashNote window, from which you can send a note and files or folders to a remote user.



Exchange
Displays the Exchange window, from which you can copy files or folders to or from a remote computer.



Control
Displays a screen-sharing window in which you can operate a remote computer using your mouse and 
keyboard activity.



Observe
Displays a screen-sharing window in which you can view the desktop of a remote computer.



Notify
Displays the Notify window, in which you can request to be notified when the remote user becomes 
active.



Chat
Displays the Chat window, in which you can post messages interactively with a remote user.



Intercom
Displays the Intercom window, in which you can have an audio conversation with a remote user.



#Connections menu



Admit Temporary Guest
Displays the Admit Temporary Guest window, in which you can grant temporary access to Timbuktu Pro 
users who are not among your registered users or Windows NT users.



Activity Log
Displays the Activity Log window, in which you can track the activities of previous and current remote 
users to your Timbuktu Pro.



<Active Users List with Icon>
The user list shows the user session in progress—the icon shows you which service is being used.



Clear Previous User List
Removes the names of previous users.



<Previous User with    Icon>
The user list shows any previous users who have connected to your computer. For a list of previous 
users, choose Activity Log from the Connections menu. Windows NT users can also look in the Event 
Viewers Application log.
 



#Help menu



Contents
Displays the Table of Contents of the online help for Timbuktu Pro.



How to use Help
Describes how to navigate through Timbuktu Pro Help. It also explains how the Help features such as 
Annotate and Bookmark work.



About Timbuktu Pro
Displays the version number, build number, and other product information of Timbuktu Pro.



#Taskbar Options



Restore
Displays the Timbuktu Pro main window.



Minimize
Reduces the Timbuktu Pro window to the taskbar. In Windows 95 and Windows NT 4.0, the icon is 
displayed in the system tray on the taskbar.



Disconnect All Users
Disconnect all the users that are connected to your system.



<Current User with Icon>
The icon shows you which service is being used. Choosing a current user    name in this menu 
disconnects the user immediately.



Address Books
Selects the Address Books tab.



Recent Connections
Selects the Recent Connections tab.



TCP/IP
Selects the TCP/IP tab.



List
Displays the items in the Address List box in List view mode. In List view mode, only the icon and the 
Computer Name are shown.



Details
Displays the items in the Address List box in Detail view mode. In Detail view mode, it shows the Default 
Service, Computer Name, Address, and Description.



Sort By
Sort the address in the address list box by service, computer name, address, description, date, ascending
or descending order.



Service
Sorts the addresses in the ascending and descending order, by service, in the address list box.



Description
Sorts the addresses alphabetically in ascending and descending order, by description, in the address list 
box.



Computer Name
Sorts the addresses in ascending and descending order, by computer name, in the address list box.



Address
Sorts the addresses in ascending and descending order, by address, in the address list box.



Date
Sorts the addresses in ascending and descending order, by date, in the address list box.



Ascending
Sorts the addresses, in the address list box, in the ascending order.



Descending
Sorts the addresses, in the address list box, in the descending order.



Open
Displays the Timbuktu Pro main window.



 How to... 
Here is an alphabetical listing of all the step-by-step procedures covered in Timbuktu Pro for 
Networks online Help. Click on any of the letters to see the relevant topics.

A    B    C    D    E    F    G    H    I    J    K    L    M    N    O    P Q    R    S    T    U    
V W X Y Z



 A
Activity Log 

Adding new registered users 

Address Books Tab 

Address List Box 

Add addresses

Admit an Ask For Permission user

Admit a temporary guest

Allowing unrestricted guest access 



 B
Blanking 



 C
Changing a registered user account 

Changing the user access privileges

Change your user password

Chat with a Remote User

Check for users

Check the activity log

Clear previous users

Close an Address Book 

Connecting to other computers 

Connection Menu 

Control another user’s computer

Create a new folder on a remote disk

Copying files from a specific folder on a remote disk 

Copying files to a specific folder on a remote disk 

Creating a new folder on the local disk 

Customize your Timbuktu Pro's Notify service 

Customize your Timbuktu Pro's General options 

Customize your Timbuktu Pro's Observe/Control service

Customize your Timbuktu Pro's Send service 



 D
Delete addresses

Delete files and folders from a remote disk

Disconnecting a remote user 



 E
Edit Menu 

Exit Timbuktu Pro without shutting it down

Enclose files in a FlashNote reply

Exchange files



 F
File Menu 

Files Received Folder 



 G
Grant a service to all guests    

Grant a service to Ask For Permission users 



 H
Help Menu 



 I
Intercom Service 



 K
Keep users out

Keyboard shortcuts 



 L
Log on

Log on as a registered user 

Log on to ask permission 



 M
Macintosh Computer Sessions, troubleshooting 

Macintosh, Receiving Files 

Macintosh, Chat 

Make Timbuktu Pro launch as a Service 

Master Password 

Menus, Timbuktu Pro 

Multiple Items in a File List 



 N
Netopia Technical Support 

Network Neighborhood Extensions 

Notify Service 

NT Event Logging 

NT logon dialog box, displaying 



 O
Observe another user's desktop 

Opening Address Books 



 P
Password Restrictions 

Preferences window 

Printing a FlashNote 



 R
Recent Connections tab 

Receive FlashNotes, files, and directories 

Registered users 

Remove a service from user access 

Removing registered users 

Remove Timbuktu Pro from your computer

Requesting Notification when a remote user is active

Removing files and folders using Exchange 



 S
Save files you receive with FlashNotes

Saving a FlashNote 

Sessions with Macintosh computers 

Setup Menu 

Select files to send

Send FlashNotes and files to other users 

Services Menu 

Set password restrictions for registered users

Setting the files received directory 

Set your master password

Set your preferences

Shut down Timbuktu Pro

Speak to a Remote User 

Support, Technical 

Start Timbuktu Pro

Stop receiving files from a user 

System Requirements 



 T
Technical Support 

The Timbuktu Pro Window

Timbuktu Pro Connection Document 

TCP/IP tab 

Toolbar, Services 

Timbuktu Pro Menus 

Timbuktu Pro System Requirements 



 U
Using online Help



 W
Windows NT Users 



 Keyboard shortcuts 
Keyboard shortcuts for Timbuktu Pro are listed below.
Note: If you type a keyboard shortcut while you are controlling another computer and a screen-sharing 
window is active, the shortcut is carried out on the remote computer only.

Commands that work anywhere in Timbuktu Pro

Action Shortcut
View context-sensitive help F1
Switch to another Windows 
application

Alt+Tab

Commands that work in the Timbuktu Pro window

Action Shortcut
Connection Tabs: Move between 
tabs 

Ctrl+Tab or Ctrl+Shift+Tab

Address Books Alt+A
Select an address in the Address 
List Box

Arrow Keys

Rename F2
Recent Connections Alt+R
TCP/IP Alt+I
Display the File menu Alt+F
Display the Edit menu Alt+E
Display the View menu Alt+V
Display the Setup menu Alt+T
Display the Services menu Alt+S
Display the Connections menu Alt+C
Display the Help menu Alt+H
System Menu Alt+Spacebar

When the File menu is displayed

Action Shortcut
Open Address book Alt+F, then O
Close Address book Alt+F, then C
Properties Alt+F, then R or Alt+Enter
Delete Alt+F, then D or Del
Exit and Shut Down Timbuktu 
Pro

Alt+F, then E or 
Ctrl+Alt+F4 

Exit Alt+F, then X or Alt+F4

When the Edit menu is displayed

Action Shortcut



Cut Alt+E, then T or Ctrl+X
Copy Alt+E, then C or Ctrl+C
Paste Alt+E, then P or Ctrl+V
Copy To Alt+E, then Y or Ctrl+Y
Rename Alt+E, then R or F2
Create Shortcut on Desktop Alt+E, then D or Ctrl+D

When the View menu is displayed

Action Shortcut
Address Books Alt+A or Alt+V, then A
Recent Connections Alt+R or Alt+V, then R
TCP/IP Alt+I or Alt+V, then I
List Alt+V, then L
Details Alt+V, then D
Sort By Alt+V then B

When the Sort By menu is displayed

Action Shortcut
Service Alt+V, then B, then S
Description Alt+V, then B, then E
Computer Name Alt+V, then B, then N
Address Alt+V, then B, then R
Date Alt+V, then B, then T
Ascending Alt+V, then B, then A
Descending Alt+V, then B, then D

When the Setup menu is displayed

Action Shortcut
Security Alt+T, then Y or Alt+Y
Preferences Alt+T, then P or Alt+P

When the Services menu is displayed

Action Shortcut
Send Alt+S, then S or Ctrl+S
Exchange Alt+S, then E or Ctrl+E
Observe Alt+S, then O or Ctrl+O
Control Alt+S, then T or Ctrl+T
Notify Alt+S, then N or Ctrl+N
Chat Alt+S, then A or Ctrl+A
Intercom Alt+S, then M or Ctrl+M
 

When the Connections menu is displayed



Action Shortcut
Admit Temporary Guest Alt+C, then G or Ctrl+G
Activity Log Alt+C, then L
Disconnect All Users Alt+C, then D
Clear Previous User Log Alt+C, then C

When the Help menu is displayed

Action Shortcut
Contents Alt+H, then C or F1

How to use Help Alt+H, then H
About Timbuktu Pro Alt+H, then A

Control menu shortcuts

Action Shortcut
Restore Alt+Spacebar, then R
Move Alt+Spacebar, then M
Minimize Alt+Spacebar, then N
Close Alt+Spacebar, then C or 

Alt+F4
Disconnect All Users Alt+Spacebar, then D
Clear Previous User List Alt+Spacebar, then E 

Commands that work in the Send FlashNote window

Action Shortcut
Display Help Alt+H or F1

Send the FlashNote Alt+S
Add Files to FlashNote Alt+A

Commands that work in the Add Files To Note window

Action Shortcut
Add a file Alt+A
Remove a file Alt+R
Done Alt+D

Commands that work in the Save Files window

Action Shortcut
Save Alt+S
Done Alt+D

Commands that work in the FlashNote window

 Action Shortcut



Reply to a FlashNote Alt+R
Save File Alt+S
Delete a FlashNote Alt+D
Save Note Alt+S
Print Note Alt+P

Commands that work in the Chat window

Action Shortcut
Insert a carriage return in your    
message

Ctrl+Enter

Print Chat Alt+P
Save Chat Alt+S
Disconnect Alt+D

General Windows shortcuts

Action Shortcut
Copy Ctrl+C
Cut Ctrl+X
Paste Ctrl+V
Undo Ctrl+Z
Select All Ctrl+A
Switch to another Windows 
application

Alt+Tab



 Definitions
Click an entry to read its definition.

Activity log Internet name
Ask for Permission user Intranet
Chat service Log in
Connect Login dialog box
Control service Notify service
Connection-menu button Observe service
Disconnect Password restrictions
Enclosure Registered user
Exchange Files service Screen-sharing window
Exchange (Delete) Security 
Exchange (Read) Timbuktu Pro
Exchange (Write) User service 
Exit User status 
Exit and shut down
FlashNote
Guest user 
Intercom service    
Internet
Internet (numeric) address



Activity log
The activity log, which can be displayed from the Timbuktu Pro Connection menu, contains information on
the operations that have been carried out on your Timbuktu Pro application.



Ask for Permission user
A user who is requesting a service that requires your permission before a remote session with your 
Timbuktu Pro can begin.



Chat service
The Chat service allows Timbuktu Pro users to post messages to one another interactively. A transcript of 
the Chat text is displayed in a scrollable panel at the top of the window and, you can print or save chat 
session details.



Control service
A Timbuktu Pro service that allows you to operate a remote Timbuktu Pro computer.



Connection-menu button
The icon to the left of the title bar. Clicking the icon opens the Connection menu for the active window. 
From Timbuktu Pro's Connection menu, you can disconnect a user, disconnect all users, and clear the 
user list. For more information, choose Menus under the Reference Help topic.



Disconnect
If you are connected to a remote computer, you disconnect by closing the Timbuktu Pro service window 
that you are using. If someone is connected to you, disconnect a user by choosing the Disconnect User 
Name from the Connection menu.



Enclosure
One or more files and folders attached to a FlashNote. When a user sends a FlashNote with enclosures 
to you, you can save the enclosures to the folder of your choice, or you can delete them.



Exchange service
The three kinds of Exchange sub-services can give a user complete access to any of your local disks and
to any server volumes you have mapped:

n Using the Exchange (Read) service, a user can copy files or folders from any folder on your computer.
n Using the Exchange (Write) service, a user can copy files or folders to any folder on your computer or 

create new folders on your computer.
n Using the Exchange (Delete) service, a user can remove files from any folder on your computer.

The three parts of the Exchange service can each be assigned to different kinds of users. For example, 
you could grant Exchange (Read) to guests users, Exchange (Write) to Ask For Permission users, and 
Exchange (Delete) to registered users.



Exchange (Delete)
A part of the Exchange Files service that lets a user remove files or folders from any folder on a remote 
Timbuktu Pro computer.



Exchange (Read)
A part of the Exchange Files service that lets a user copy files and folders from any folder on a remote 
Timbuktu Pro computer.



Exchange (Write)
A part of the Exchange Files service that lets a user copy and modify files and folders to any folder on a 
Timbuktu Pro computer.



Exit
Choosing Exit—from the File menu or from the pop-up menu of the Timbuktu Pro icon on the taskbar in 
the system tray of the toolbar—closes the main Timbuktu Pro window but leaves Timbuktu Pro running in 
the background. Remote users can still connect to your computer.
To end all Timbuktu Pro activity, choose Exit and Shut Down Timbuktu Pro instead of Exit.



Exit and shut down
Choosing Exit and Shut Down Timbuktu Pro from the File menu stops all Timbuktu Pro activity. Remote 
users will not be able to connect to your computer.
If you want to close the main Timbuktu Pro window but allow Timbuktu Pro to continue running in the 
background, choose Exit instead of Exit and Shut Down Timbuktu Pro.



FlashNote
A FlashNote is a message that you can send to a remote user using the Send service.
Note: You can attach files, or folders to a Flashnote.



Guest user
A person who can connect to your Timbuktu Pro computer without having to type a password.



Intercom service
Allows local and remote users to talk with each other through their computer’s audio hardware.
Note: Both computers must be equipped with sound cards, microphones, and speakers.



Intranet
A network—which may be connected to the Internet—that is used by an organization primarily for internal 
activity rather than for communication with the outside world. To protect the security of the organization's 
computer systems and information, intranets are often equipped with an electronic barrier, known as a 
firewall, that can selectively prevent different forms of data traffic originating outside the intranet from 
reaching computers inside the intranet.



Notify service
Creates an electronic request to be notified when another Timbuktu Pro remote user has started using 
their computer.



Log in
To type the name and password in the Timbuktu Pro log in dialog box before beginning a session with a 
Timbuktu Pro computer. Logging in is required only if you are using a registered user account.



Login dialog box
The Timbuktu Pro Login dialog box is displayed to users who request services that are restricted to 
registered users or that require Ask For Permission. If the service a user requests is assigned to guest 
users and NT users, the Login dialog box is not displayed.



Observe service
A screen-sharing service where you can view the activity on a remote user’s desktop but cannot operate, 
or affect the remote computer. The desktop screen appears in a scrollable screen-sharing window.



Preferences
The Preferences option in the Setup menu displays the Preferences window. The Preferences window 
contains tabs that let you customize the user interface for the Send, Observe/Control and Notify services. 
You can also specify a master password, and specify whether Timbuktu Pro will be launched 
automatically when Windows starts up on your computer.



Password restrictions
Three options that you can select by clicking the Password Restrictions button in the Registered users tab
of the Security window. The password restrictions can define an expiration date on all passwords, set a 
minimum length for all passwords, and require new passwords created by users not to match any of their 
three previous passwords.



Screen-sharing window
The Observe and Control services let you view the desktop activity of another computer in a special 
window called the screen-sharing window. Everything displayed in the screen-sharing window is coming 
from the screen of the remote computer. You can scroll this window automatically by moving your pointer 
toward the border of the screen-sharing window. 



Security
The Setup->Security option displays the Security window. In the Security window, you can assign user 
services such as Send, Exchange, Observe, Control, Notify, Chat, and Intercom.
Guest users are not required to type a password.
Registered users must always enter a name and password to use the services assigned to their accounts.



Connect
To establish a session between your computer and a remote Timbuktu Pro computer.



Remote user
A person who has opened a session to your Timbuktu Pro computer.



User service
Any of the forms of access that a remote user can have with a Timbuktu Pro computer if granted 
permission by the Timbuktu Pro user. Services include Send, Exchange, Observe, Control, Chat, 
Intercom, and Notify.



Internet
A world-wide network connecting businesses, governments, researchers, and educators. Data is 
transferred across the Internet by the Transmission Control Protocol/Internet Protocol (TCP/IP).



Internet address
A set of numbers—in the form 123.45.67.89—that uniquely identifies a computer that is connected to the 
Internet. Some users have unchanging (static) Internet addresses, whereas others have dynamic 
addresses, which change each time the user connects to the Internet.



Internet name
A name, such as timbuktuwindemo.netopia.com, that can be typed in the Address box of the Timbuktu 
Pro window so that you can connect to the Timbuktu Pro at that address.



Registered user
An account you can create in the Timbuktu Pro Security window’s Registered Users tab. A registered user
account requires the registered user to enter a user name and password to connect to your Timbuktu Pro.



User status
There are four kinds of user status: Guest users, Ask For Permission users, Registered users and 
Windows NT users. Guest users are not prompted for a user name or password. Ask-for-permission users
are required to ask for permission from a Timbuktu Pro remote user before they can use the services they
request. Registered users must type their user names and passwords to access a Timbuktu Pro remote 
user, but they don't require the remote user to be present at his or her Timbuktu Pro computer. Windows 
NT users are authenticated by NT. Your current user name and password is used. If you are authenticated
then you connect immediately.



Timbuktu Pro
Timbuktu Pro is a powerful network remote control software. Timbuktu Pro is ideal for workgroups, remote
workers and help desk administrators.
Timbuktu Pro users can access corporate network resources, transfer files, remotely control other 
computers, and remotely work with other users in real time to collaborate on projects. The full set of 
Timbuktu Pro service buttons are: Send, Exchange, Observe, Control, Notify, Chat, and Intercom.



 Troubleshooting
Send service  
Exchange service
Observe and Control services
Intercom service
Memory problems
Sessions with Macintosh computers
TCP/IP information
Firewalls 



 Send service
Extended characters in file names
File names that use symbols from the extended character set (characters with an ASCII value greater 
than 128, usually entered with the Alt key) may not be displayed correctly when you are selecting them in 
the Add Files to FlashNote window. To make sure that your file names are displayed correctly, use only 
the characters that are visible on your computer's keyboard (with or without the Shift key).

Extended characters in folder names
Don't use extended characters in folder names. (Timbuktu Pro lets you create a new directory in the Save
Files window that contains a symbol from the extended character set, but when you try to save files to 
that folder, the files disappear.)

Cannot send file with special characters in the name
You cannot send a file with certain diacritical marks in the file name. For example, the file Béta.txt cannot 
be transferred using the Send command. An error is displayed when you try to add it as an enclosure. You
can work around this by putting the file in a directory and then sending the directory, or you can rename 
the file before sending it.

Cannot reply to FlashNote
Unlike sending electronic mail, sending FlashNotes requires the sender and receiver to be running 
Timbuktu Pro at the same time. If you are unable to reply to a FlashNote from another Timbuktu Pro user, 
check to see if the other user has switched off Timbuktu Pro.

Send command sometimes fails to transfer files within large directory enclosures
If you include a directory as an enclosure in a FlashNote, and if that directory goes many levels deep, 
Timbuktu Pro may not be able to transfer some of files in the lower levels of the directory.
For example, you include the c:\sales directory in a FlashNote, and within that directory, you go as 
deep as
c:\sales\southern\quarter4\phase2\hardware\copper\judy\data\sales.doc.
This path is less than the maximum 64-character path that DOS allows. But when Timbuktu Pro adds the 
drop directory name, sender directory name, and date/time directory name

c:\files\jane\10-31-12.32I

the path name becomes longer than DOS permits.

You can avoid this by transferring individual directories from inside the sales directory. For example, 
instead of including c:\sales, include c:\sales\southern\quarter1 and c:\sales\southern\
quarter2, etc. This shortens the final directory depth in the recipient's drop directory.

Alternatively, if you have access, you can use Exchange instead of Send, and copy the c:\sales 
directory to the root level of the recipient's disk drive. This avoids adding the extra path of the drop 
directory.

The Send function reports that the remote computer is out of disk space
There are two possibilities:

n The remote computer is out of disk space.
n The Protect Megabytes of disk space from use by files received directory value in the Preferences 

dialog box could be set too low.
In either case, the remote user will have to be the one to solve the problem by clearing some space on his
or her hard drive, or by resetting the amount of space that Timbuktu Pro is to protect.





 Exchange service
Extended characters in file names
File names that use symbols from the extended character set (characters with an ASCII value greater 
than 128, usually entered with the Alt key) may not be displayed correctly when you are selecting them to 
copy to another computer. To make sure that your file names are displayed correctly, use only the 
characters that are visible on your computer's keyboard (with or without the Shift key).

Hidden files
Timbuktu Pro does not copy hidden files between computers.
If you see an unexpected "Replace files?" message when you are copying files to your computer or to a 
remote computer, Timbuktu Pro may be about to replace (overwrite) a hidden file. In that case, you may 
want to cancel the transfer and copy the file to a different folder.

File transfer speed
Copying many small files is significantly slower than copying one large file.

Long file names
When copying files to Timbuktu Pro 1.x, Timbuktu Pro must shorten long file names to conform with the 
8.3 name+extension format.    If it shortens two similar long file names to the same reduced name, it will 
copy the first file and then attempt to replace it when it copies the second file.    A workaround is to rename
one of the files before copying it.

Multiple sessions
If you already have an Exchange session open with another computer, you can't start another Exchange 
session with that computer until the first one is closed.

Warning: If the Exchange privilege is granted, the remote user will be able to access the files on your 
hard disk, as well as files on any network drive that you are currently logged into.
DO NOT grant Exchange privileges if your computer contains sensitive, or confidential information.

Extended characters in folder names
Exchange won't prevent you from creating a folder with a symbol from the extended character set, but the
symbol—which may display correctly in the Create New Folder window—will probably not be retained 
after it is created or after it is copied to another computer.

Subservices not granted
The remote computer you are connecting to may let you begin an Exchange session and then refuse to 
perform the desired subservice (Read, Write, or Delete). The problem can arise when only one or two of 
the three Exchange subservices has been granted to guests or registered users. Timbuktu Pro can't make
this distinction at the time you log in, but when you actually try to use a subservice that you don't have, 
Timbuktu Pro won't let you continue.
You may be able to obtain the desired subservice on a temporary basis by contacting the Timbuktu Pro 
remote user.



 Observe and Control services
Viewing DOS programs
If you are observing or controlling a remote computer whose application or owner switches to a full-screen
DOS window, you may notice parts of the screen, such as icons, that are black or have their colors 
reversed, and you won't be able to control anything in the window.
If you are using the Control service, you can regain control of the screen-sharing window by pressing 
Alt+Enter to change the full-screen window back into a DOS window.

Animation applications
Animations viewed in a screen-sharing window are not smooth and may contain gaps. In addition, the 
computer originating the animation may be slowed to the point of becoming unusable. If network output 
buffers are completely filled, no animation can be displayed on the originating computer until a part of the 
buffer's contents is sent.

If you are connecting to a remote computer that is running an animation, try disconnecting until the 
sequence has finished and then reconnecting.

DirectX games API
Unfortunately, DirectX games API bypasses GDI (Graphical Device Interface). Therefore, applications that
use this API, such as Fire Fight, can't be viewed in the screen-sharing window. If you control a computer 
that is running such an application, you'll see the desktop but none of the windows that are displayed by 
the application.

Low memory
If you attempt to connect to another computer and your computer has very low Windows User memory or 
very low GDI memory, you won't be able to use the Observe service or the Control service.
Memory problems 

Changing screen size
If the remote computer you are observing or controlling changes its "virtual desktop size,"—using, for 
example, quickres.exe from Microsoft's PowerTools for Windows 95 or Flexdesk+ from ATI's Desktop 
control panel—your computer will experience a stack overflow. To prevent this, ask the remote user to 
wait until the screen-sharing session has ended before resizing.

Name of Macintosh computer is not displayed correctly in your screen-sharing window
The Macintosh user may have used extended characters in his or her computer name. Windows does not
allow Timbuktu Pro to transfer symbols from the extended character set correctly.



 Intercom service
If you are having trouble with the Intercom service, make sure you have taken the following hints into 
consideration:
Make sure you've set the volume control for your sound card properly.
Using the Windows Volume Control accessory 

Make sure the microphone and speaker levels are set correctly.
Adjusting your microphone and speaker levels 

n Don't speak too closely to the microphone. It also helps to direct your speech slightly to the side of the 
microphone.

n Use the Sound Recorder multimedia accessory to make sure you can record sound and play it back.
n Make sure you're using the right Sound Compression setting. If the other user is on the same network 

(LAN) with you, select None.
n If you switch compression methods—None, GSM—during an Intercom session, don't speak while you 

are switching. This can degrade the sound quality.
n If the sound card on your computer or the one you are connected to is already being used by another 

application—for example, recording or playback—you won't be able to begin your Intercom session 
until the other application has been closed.

n If you run more than one operating system or IP stack on your computer, you'll need to install 
Timbuktu Pro on each operating system/stack combination.

n In Intercom, if you have a CD player playing on the guest side, the host side might also hear the sound
from the CD. There is a way to stop this in “Volume Control” .

Note: The intercom button will not be active if you don’t have a sound card installed.



 Memory problems
Low DOS memory
If Timbuktu Pro does not run or you cannot run other Windows applications when Timbuktu Pro is running,
you may be experiencing a low DOS memory problem. Because Windows for Workgroups (or Windows 
3.x) sits on top of DOS, Windows applications and the Windows operating system need a certain amount 
of low memory, that is, memory below 1MB. This problem usually appears on portable computers that use
PCMCIA socket service drivers. However, desktop systems can also have the problem.

Try one or more of the following suggestions to free up memory
Review the list of DOS drivers and TSRs you are using and stop loading the less important ones. 

n Maximize low DOS memory by using a Memory Manager such as EMM386 or QEMM to load DOS 
drivers and DOS TSRs into upper memory. Refer to your memory manager documentation for specific 
instructions.

n Limit the number of Windows applications you have open at one time.

Low Windows memory
You may also experience difficulties if your computer or the computer you are controlling is low on 
Windows memory. The following problems may indicate low Windows memory:

n Your mouse pointer isn't moving as smoothly as usual.
n Your screen partially redraws and then stops for 100 seconds.
n A Control window closes if you maximize it.
n Windows are only partially drawn.
n Windows are drawn larger than usual.
n Your remote session is terminated unexpectedly.
n You can't visit a remote computer even though Timbuktu Pro is runningthis indicates insufficient 

memory on the remote computer.

You can free Windows memory by closing unneeded applications. You may also need to add RAM to your
computer.



 Sessions with Macintosh computers
Overwriting files with identical names
Some Macintosh directories and files may have names that are identical to the those being transferred 
from your PC. When this happens, you get the message, "Replace items with the same names with the 
selected items?" If you click Yes, the files and directories on the PC will overwrite those files on the 
Macintosh that have the same name. The original Macintosh files will be lost.

Problems controlling a Macintosh
When a PC user is controlling or observing a Macintosh computer:

n The colors in the Control or Observe window of the PC may not exactly match the colors on the 
Macintosh.

n When the Macintosh is running FrameMaker 4.0, the text in the FrameMaker menus may not be 
visible to the PC controller or observer. Make sure the Macintosh user has switched on Support 
Bypassing QuickDraw in the Preferences dialog box.

n Buttons on a Macintosh application may sometimes not be visible to the PC controller or observer, but 
they are still functional.

Problems connecting to a Macintosh
Make sure the Macintosh user is running Timbuktu Pro for Macintosh 4.0.2 or later.

Cross-platform passwords cannot use extended character sets
Characters that are not shared between your PC and a Macintosh cannot be used in passwords. 
Passwords that are to be used across platforms should consist of the basic characters that both platforms
share.

Extended characters and file transfer
If you are using the Exchange service with a Macintosh, you may notice that some of the file names in the
lower panel of the Exchange window do not appear correctly. This is because some special characters 
(usually referred to as upper-128 ASCII characters) may not map correctly between Windows and 
Macintosh systems. Examples of these special characters are ones that require the use of the Ctrl or Alt 
keys. This special character limitation also applies to passwords.

To ensure cross-platform compatibility, use only the characters that are visible on your computer's 
keyboard (with or without the Shift key). If you want to compare cross-platform character mapping in more
detail, you can check the character resources on each platform by using the Windows Character Map 
accessory program and the Macintosh Key Caps program.

File types not always recognized by the other computer
If you transfer certain kinds of files to a Macintosh, the files will not appear in the directory dialog box 
when you attempt to open them from the corresponding Macintosh application. This is because Timbuktu 
Pro does not always assign the correct Macintosh Type and Creator values to Windows files during a 
Send or Exchange session.

You can, however, edit the FILEMAP.INI file, which ships with Timbuktu Pro, so that Timbuktu Pro will 
translate any 3-letter extension of a DOS file type to the appropriate Type and Creator values for a 
Macintosh file type and vice versa. Click the link below to learn how.
File Extension Mapping 

Copying to a Macintosh floppy disk
If you are using the Exchange service to copy files to a floppy disk on a Macintosh, you may get an error 
message that the floppy disk is full even though the Macintosh user has just deleted files from that disk.
To work around this problem, close the Exchange window and open a new one to the same Macintosh. 
This causes Timbuktu Pro to recheck disk space available on the Macintosh floppy disk.



Macintosh file format information
A Macintosh file consists of a resource fork and a data fork. Timbuktu Pro copies only the data fork and 
uses the information in the resource fork to set file properties. Therefore, any Macintosh file that has an 
empty data fork—for example, the Shrinkwrap.Frontier file—is copied to a file with zero contents on a 
Windows computer.

Line breaks not inserted
When Timbuktu Pro copies a Macintosh text file to your computer, no additional control characters are 
added to force line breaks. When such a document is opened on some PC text editors—for example, 
WordPad—it is displayed as a single, very long line.    A workaround is to open the document with a word 
processor that has an automatic word wrap feature, such as Microsoft Word, and then save the document
in an appropriate PC format.



 TCP/IP information
Do not control your local computer over TCP/IP
Please do not attempt to control your own computer over TCP/IP; it will crash your system.

No TCP/IP connection tab
If the TCP/IP connection tab does not appear in your Timbuktu Pro window, first of all, make sure that 
your TCP/IP software is compatible with Timbuktu Pro. Refer to the Timbuktu Pro for Windows Release 
Notes for the most up-to-date information.

If you are using an approved stack, make sure that your IP network software is working properly outside 
of Timbuktu Pro. Try other Windows Sockets IP applications, such as Netscape, Telnet, or ftp. If these 
aren't working either, the problem is more likely to be with your IP stack rather than with Timbuktu Pro.

Error Message: Computer Name does not match
If you connect to an address saved in an address book and learn that the Computer Name does not 
match, you may have saved a dynamic IP address. That address may have since been assigned to a 
different computer.

Cannot connect to an TCP/IP address
If you cannot connect to an TCP/IP address, check the following:

n Make sure that you are entering the TCP/IP address correctly.
n Can other computers connect to the Timbuktu Pro computer?    Can this Timbuktu Pro computer 

connect to another Timbuktu Pro computers?
n If you can access the Internet try observing our test machines at 163.176.4.43 or 163.176.4.44.
n Make sure that the TCP/IP address you are using is current.    If the remote computer is using a 

dynamic TCP/IP addressing, the address may now be different.    Please call or email the user to find 
out their current TCP/IP address.

n Make sure you are able to connect to other Timbuktu Pro computers using TCP/IP.    If not, the 
problem may lie with your TCP/IP configuration. 

n Can you use the ping utility and “ping” the remote machine?    A response of "request timed out" 
indicates you do not have a TCP/IP connection between the two machines. 

Given below are a few reasons why you may be unable to connect to a TCP/IP address: 
1 TCP/IP is not configured correctly.
2 The computer is not connected to the Internet.
3 There is a Firewall. For more information, see Firewalls.
4 There is a misconfiguration on a router or the physical connection. If only some of the packets come 

back, it usually indicates a problem such as bad cabling, a slow Internet connection or a busy Network
connection.

n If you entered a DNS name, try using the (numerical) TCP/IP address instead. For example, instead of
typing tb2win.farallon.com, type 163.176.4.44.

n The remote computer may not be accessible because of a security firewall—on your network or on the
remote network. To determine whether Timbuktu can use TCP/IP on your network, check with your 
Network Administrator to see if there is a Firewall.    The utility, trace route, can often indicate a firewall 
or other routing problems.    If you can not trace route to the machine, you probably will not be able to 
connect to it either.    

n Type, "tracert <tcp/ip address>" at a DOS prompt.    For example, "tracert 163.176.4.43".    The 
response will give the TCP/IP address of every router between you and the remote address and the 
time it took to reach that router.

n For more information, see “Firewalls” or the technical note on our web site 



http://www.netopia.com/support/technotes/software/tb2mac/TPM_031.html—Firewall Issues
n Are you using Dial Up Networking or a Point to Point Protocol    (PPP) connection?    Do other TCP/IP 

applications, like FTP or your Browser, work over the dial up connection? If you need a PPP server, 
the Remote Access Server (RAS) that ships with Windows NT is recommended.    Please refer to 
Microsoft for proper configuration.    

Note: For help in configuring Windows 95 Dial Up Networking, please see the following URL’s:
                  http://www.windows95.com/connect/ppp.html—Client Set Up
                  http://www.windows95.com/connect/dialsrvr.html—Server Set Up

n Make sure the computer you have selected has TCP/IP incoming access turned on if it is running 
Timbuktu Pro v1.x earlier or is if it is a Macintosh.

n Make sure the computer you’ve selected is running Timbuktu Pro. If it is a Macintosh, it must be 
running Timbuktu Pro for Macintosh 4.0 or later with TCP/IP installed and properly configured.

Note: For more tips on configuring TCP/IP on for Macintosh, please see the following technical notes 
http://www.netopia/support/technotes/hardware/NQG_004.html for information on “How to set up 
TCP/IP on a Macintosh”.

Connection Tips
You may experience problems during a remote control session, if you use any service like Control, 
Observe, Send or Exchange with the same computer you are controlling or observing.

Warning: Do not attempt to control or observe your own computer over TCP/IP; it will crash your system.



 Firewalls
Some types of Timbuktu Pro connections via TCP/IP may appear to be blocked because of Firewalls.

Firewalls in general
For security reasons, network managers on TCP/IP networks usually want to restrict external access to 
their networks. Most of the time they will only open TCP/UDP ports for Telnet, FTP, and some other 
common services access. To do that, they configure their TCP/IP routers—sometimes referred to as 
gateways—to filter out access to different ports. These filters are called firewalls and can be configured to
prevent Timbuktu Pro connections. In order for Timbuktu Pro to access these kind of networks, the 
network manager must open the TCP ports which Timbuktu Pro requires.

Firewalls and Timbuktu Pro
Timbuktu uses a well-defined UDP port, 407, for connection handshaking and then switches to other TCP 
ports for each kind of service:

Service TCP Port
Control 1417
Observe 1418
Send Files 1419
Exchange Files 1420
Notify Dynamic TCP/IP ports above 1023
Chat Dynamic TCP/IP ports above 1023
Intercom Dynamic TCP/IP ports above 1023

These ports are used during access from registered users. Any or all of these ports can be protected by a 
firewall to keep out unauthorized users. Some network managers firewall all ports but 407 and 1419, 
which allows anyone on the Internet to send a user a file via Timbuktu Pro. We provide the ability for the 
network administrator to reconfigure the ports that Timbuktu Pro uses by using Timbuktu Pro 
Administrator’s Toolkit to set up a particular site. Timbuktu Pro also supports attended access, in which a 
remote user admits a temporary guest on a one-time basis without requiring a password. Timbuktu Pro 
normally uses a dynamic port assignment for this type of connection. Temporary guest access can be 
allowed through some firewalls that do not allow registered user access.

Only computers receiving a connection use registered port numbers. The users who initiate connections 
use dynamic—random or ephemeral—port numbers. Such ports have numbers above the 256 reserved 
ports and are usually above port 1023. Most Internet sites follow the convention of allowing ports greater 
than 1023 to be assigned to TCP/IP applications dynamically. If these dynamic ports are firewalled, 
Timbuktu Pro will not be able to complete a TCP/IP connection.

How to handle a firewall
The network manager will need to reconfigure the firewall permissions to permit dynamic TCP and UDP 
port assignments. Refer to the firewall or router documentation for details.

Note: Using the Timbuktu Pro Administrator’s Toolkit, Timbuktu Pro Enterprise customers can 
designate which TCP/IP ports are to be used for Timbuktu Pro services. For more, please contact your
local sales person or visit our Web site by using the following URL:
http://www.netopia.com/software/tb2/enterprise/



Using the Windows Volume Control accessory
After you have installed your sound card, follow these steps to set its volume properly.

To set the volume on your sound card:
From the Start menu, choose Programs, then Accessories, then Multimedia, then Volume Control. The 
Volume Control window is displayed.

n To adjust the playback volume, drag the Volume Control slider up to raise the volume and down to 
lower the volume.

n To change the balance between the left and right speakers, drag the Balance slider.

Tip: If your computer has more than one device (for example, a MIDI or Wave device), you can set the 
volume for each device.

To learn more about the controls, choose Help Topics from the Help menu of the Volume Control window.



 Reference
Key to Timbuktu Pro Icons 
File Extension Mapping 
Firewalls 

Also See:
Definitions
Menus



 Key to Timbuktu Pro Icons

The Timbuktu Pro application icon  is displayed in the system tray of the taskbar whenever Timbuktu 
Pro is running on your computer.

The following icons are displayed in alternation with the application icon when a remote user is using a 
Timbuktu Pro service with your computer. A dimmed icon indicates a remote user who is no longer 
connected to your computer.

User
Icon

Meaning

    A remote user    is using the Send service with your computer.

    A remote user is using the Exchange service with your computer.

    A remote user is using the Observe service with your computer.

    A remote user is using the Control service with your computer.

    A remote user is using the Chat service with your computer.

    A remote user is using the Intercom service with your computer.

    A remote user is using the Notify service with your computer.



 File Extension Mapping
This topic provides technical information for users who frequently copy files between Windows and 
Macintosh computers and who are not getting the automatic file name conversions they need.
Overview of File Extension Mapping 
Adding new file mapping extensions    

See also
Receiving Files from a Macintosh computer 



 Overview of File Extension Mapping
Many DOS and Windows applications identify documents according to the 3-letter extension in the file 
name, for example, the DOC in LETTER1.DOC. Such applications require certain types of extensions in 
file names in order to display them in their Open dialog boxes.
Macintosh applications, on the other hand, do not recognize file extensions, but instead use identifiers 
called Type and Creator, which are not normally visible to the Macintosh user. Type and Creator can be 
displayed by such utilities as ResEdit, Find File and DiskTop.
When copying files between a Windows computer and a Macintosh, Timbuktu Pro attempts to add (or 
map) file identifiers so that when the files are saved on the recipient's computer, they will have the 
information that the applications need to recognize them.
The FILEMAP.INI file
The tables of information Timbuktu Pro uses to perform file name mapping are kept in the FILEMAP.INI 
file in the Timbuktu Pro folder and are displayed later in this topic.
Whenever you transfer a file to a Macintosh, the [PC To Macintosh] section of FILEMAP.INI is scanned 
for a matching file extension. If the extension is found, the Macintosh Creator and Type values are copied 
to the file from the same line in the [PC To Macintosh] section.
In like manner, whenever you receive a Macintosh a file, the [Macintosh To PC] section of FILEMAP.INI 
is scanned for a Type and Creator match. If a line with matching Type and Creator is found, the DOS 
extension is copied to the file from the same line in the
[Macintosh To PC] section.
If you are using files that have extensions, Types, or Creators that are not currently mapped in 
FILEMAP.INI, you can add new lines to the appropriate section of the file, as explained in the following 
procedures. This will save you from having to manually rename extensions or reset Type and Creator 
values following file transfer.
Adding new file mapping extensions 
Macintosh to DOS conversion 
DOS to Macintosh conversion 



 Adding new file mapping extensions
You are initially limited to the entries of the FILEMAP.INI file, explained in the previous section. 
However, you can add an extension mapping entry for any application you have. There is no limit to the 
number of entries you can add.
This section contains two procedures for adding new file mapping extensions. The first is for mapping 
Macintosh file names to DOS file names. The second is for mapping DOS file names to Macintosh file 
names.
Macintosh to DOS conversion 
DOS to Macintosh conversion 



 Macintosh to DOS conversion
The following procedure explains how to add file mapping extensions so that when you transfer a file with 
a specific Type and Creator combination from a Macintosh to your Timbuktu Pro, the file will have the 
desired 3-letter extension when it is saved on your computer.

To map Macintosh file names to DOS file names:
1 Find out the Macintosh Type for the document you will be transferring to the Windows computer. To do

this, open the document with a utility such as ResEdit and choose Get Info from the File menu. 
Each value will be four characters long. 

2 Using a DOS or Windows editor, open the FILEMAP.INI file. It should be in the Timbuktu Pro 
directory.

3 Find the [Macintosh To PC] section.
4 Add your new entry just before the last entry in the list and use the mapping number of the last entry. 

Use the following example as a model

FileMapping52=“SAFR” * “SFR”  “0” ; Comments

In this example,

FileMapping52= is the label for this line; if 52 was not the last number in the list when you began 
this procedure, use the actual last number in the label instead of 52.

SAFR is the Type value of the Macintosh document.
* is a wild card character; this causes Timbuktu Pro to ignore the Macintosh Creator value when 
converting the file name. However, if you want this line to be applied only to documents from a specific
Macintosh application, type its 4-letter Creator string (for example, SFII) in this position instead of the 
*.
SFR is the 3-letter DOS extension you want the file to have when it is saved on the Windows 
computer.
0 is a field reserved for future development; leave it as it is.

It is important that you match the spacing on your new line to the spacing used on the neighboring 
lines in the FILEMAP.INI file.

5 Change the mapping number on the last entry to one number greater than its previous value. For 
example, if the last entry was "FileMapping52", change it to "FileMapping53".

6 Save the changes to the FILEMAP.INI file.
7 Restart Timbuktu Pro.

DOS to Macintosh conversion 



 DOS to Macintosh conversion
The following procedure explains how to add file mapping extensions so that when you transfer a file with 
that extension from a PC to a Macintosh, the file will have the correct Type and Creator when it is saved 
on the Macintosh.

To map DOS file names to Macintosh Type and Creator:
1 Find out the Macintosh Type for the document you will be transferring to the Windows computer. To do

this, open the document with a utility such as ResEdit, or Find File and choose Get Info from the 
File menu. Alternatively, use Find File, select more choices, use the down arrow by name and 
select type.

2 Using a DOS or Windows editor, open the FILEMAP.INI file. It should be in the Timbuktu Pro 
directory.

3 Find the [PC To Macintosh] section.
4 Add your new entry just before the last entry in the list and use the mapping number of the last entry. 

Use the following example as a model:

FileMapping56=“SAFR” * “SFII” “SFR” “0” ; Comments

In this example,

FileMapping56= is the label for this line; if 56 was not the last number in the list when you began 
this procedure, use the actual last number in the label instead of 56.

SAFR is the Type value you want the file to have when it is saved on the Macintosh.
SFII is the Creator value you want the file to have when it is saved on the Macintosh.
SFR is the 3-letter DOS extension with which the document was saved on the Windows computer.
0 is a field reserved for future development; leave it as it is.

It is important that you match the spacing on your new line to the spacing used on the previous lines in
the FILEMAP.INI file.

5 Change the mapping number on the last entry to one number greater than its previous value. For 
example, if the last entry was "FileMapping56", change it to "FileMapping57".

6 Save the changes to the FILEMAP.INI file.
7 Restart Timbuktu Pro.

Macintosh to DOS conversion 



 Receiving Files from a Macintosh computer
You can receive files from Macintosh computers Timbuktu Pro for Macintosh over a TCP/IP network. 

Timbuktu Pro does not change Macintosh file names.    However, file names that use characters from the 
Macintosh extended character set may contain different characters in place of the extended characters. 
Rename any files with extended characters before sending or exchanging.



 Removing Timbuktu Pro from your computer
Removing Timbuktu Pro from your computer will delete all Timbuktu Pro registered users, address books, 
and security preferences.

To remove Timbuktu Pro from your computer:
1 Exit and Shut Down Timbuktu Pro.
2 Select Start>Programs>Timbuktu Pro>Timbuktu Pro Uninstaller.
3 Click yes to confirm.
4 Restart.

Note: Address book information is stored in the Timbuktu Pro installation directory and will be deleted 
if you uninstall the product.



 Using Online Help
Timbuktu Pro's comprehensive online help provides a variety of ways to answer your questions. It 
contains step-by-step instructions for all common procedures, as well as troubleshooting hints and 
keyboard shortcuts.

To open Timbuktu Pro’s online Help:

1 With the Timbuktu Pro window active, press F1 or choose the Contents option from the Help menu.
2 Highlight a command from one of Timbuktu Pro's menus and press F1 to display the online Help topic 

associated with that command.

Note: To display Help for the screen-sharing window (Control and Observe services), click the Control-
menu icon in the upper left corner of the screen and choose Help.

The Windows Help file explains using and navigating through help.

Help Contents



 Help Contents
Help basics

Getting Help from your application

Advanced features in Timbuktu Pro

Moving around in Help

Keeping Help on top of other windows

Displaying Help contents

Searching for a Help topic

Returning to a Help topic you have viewed

Choosing a jump

Scrolling through a Help topic

Viewing an application and Help together

Opening another Help file

Glossary

Annotating a Help topic

Printing a Help topic

Copying a Help topic onto the Clipboard

Viewing an Annotation

Removing an Annotation

Adding text to a Help topic

Copying and pasting an Annotation

Defining and using Bookmarks

File menu commands

Edit menu commands

Bookmark menu commands

Help menu commands

Help buttons



 How to Use Help
If you are new to Help, choose Help basics.
Use the scroll bar to view information not visible in the Help window. An item identified with a bullet ( ) is 
usually one of a number of equivalent choices.

To choose a Help topic
n Click the underlined topic you want to view.
n Press Tab to select the topic, and then press Enter.

 Understanding and navigating Help
Help basics
Getting Help from your application
Advanced features in Timbuktu Pro
Moving around in Help
Keeping Help on top of other windows
Viewing an application and Help together
Opening another Help file
Glossary

 Personalizing and printing Help
Annotating a Help topic
Defining and using Bookmarks
Printing a Help topic
Copying a Help topic onto the Clipboard

 Help commands and buttons
File menu commands
Edit menu commands
Bookmark menu commands
Help menu commands
Help buttons



 Help basics
Windows Help offers a quick way to find information, such as how to perform a particular task. Within a 
Help topic, there may be one or more jumps, which you can click (or press Tab to select the topic, and 
then press Enter) to display a new Help topic.
Jumps to related topics, if they exist, are usually indicated with green underlined topic headings at the end
of paragraphs or topic entries. Click on them to move directly to the related topics.
You can move, resize, maximize, or minimize the Help window, just like any other window. To return to 
Contents for How To Use Help, click the Contents button. To return to the main Timbuktu Pro Help table of
contents, click the Contents button again.



 Getting Help from your application 
You can get Help while using an application by choosing a command from the application's Help menu or 
by pressing F1. Some applications also have a Help button in dialog boxes.

To access Help from an application
n From the Help menu in the application, choose a Help command. 
n Press F1 while using the application. 
n Click the Help button in a dialog box. 

A Help window appears. The topic that is displayed depends on which Help command you chose, what 
was selected when you pressed F1, or which dialog box you were using when you chose the Help button.
With some applications, the Help Contents for the application appears. With other applications, a Help 
topic on the selected command or dialog box appears. 
Note: If F1 does not display Help, you must use the application's Help menu. 



 Advanced features 
This section explains the additional Help features found in Timbuktu Pro.

Clickable icons
Many icons in this document are clickable.

n Clicking an icon in the body of the Help topic displays the associated subtopic, if a subtopic exists.

Menu command + F1 key = Help
To quickly access online Help for a specific Timbuktu Pro menu command, press the F1 key while 
highlighting the menu command. Timbuktu Pro online Help displays the Help topic for that command.

Automatic return to the Timbuktu Pro table of contents
If you are viewing a topic in How to Use Help, clicking the Contents button returns you to the How to use 
Help table of contents. If you are already viewing the How to use Help table of contents, clicking the 
Contents button returns you to the main Timbuktu Pro table of contents.



 Moving around in Help 
You can use the Help button bar to move around in Help. You can go back to topics you've viewed 
previously. You can search for specific information or display Help Contents. You can also choose a jump 
to go to a new Help topic. For more information about moving around in Help, choose one of the following
tasks: 
Displaying Help Contents (the   Contents   button)   
Searching for a Help topic (the   Search   button)   
Backtracking through Help topics (the   Back   button)   
Returning to a Help topic you have viewed (the   History   button)   
Displaying Timbuktu Pro keyboard shortcuts (the   Shortcuts   button)   
Choosing a jump
Scrolling through a Help topic



 Displaying Help contents 
Help Contents lists available Help topics. If you are viewing a Help topic and you want to return to the 
most closely related Help table of contents, use the Contents button.

To display Help Contents from within Help
n Click the Contents button in the Help button bar.

Getting Help from your application



 Searching for a Help topic 
You can find information quickly by using the Search button in the Help window. The Search button opens
the Search dialog box, where you select a word that you want to search for. All Help topics associated 
with that word are listed, and you can select one to view. For example, to find out how to save a file, you 
could select "save" from the list. Topics that have the word "save" associated with them would then be 
listed in the Search dialog box. 

To search for Help information
1 In the Help button bar, click the Search button.
2 Select the word or phrase you want to search for. When you start typing, the words that most closely 

match the text you type are displayed.
3 Click the Show Topics button. 
4 Select the topic you want to view. If necessary, use the scroll bar to see more topics. 
5 Click the Go To button. 



 Backtracking through Help topics 
Use the Back button to go back through the Help topics you have viewed, in the order in which you 
viewed them. If there is no previous topic to view, the Back button is dimmed. The record of topics you 
have viewed is removed each time you quit Help. 

To backtrack through Help topics
n Click the Back button on the Help button bar. 

You return to the previously viewed topic. The topic appears as you left it, unless you resized the window 
before backtracking. 



 Returning to a Help topic you have viewed 
You can use the History button to see a list of the previous 40 Help topics you have viewed. The most 
recent topic appears first. To return to a topic, choose it from this list. 

To use the History button to return to a topic
1 In the Help button bar, click the History button.
2 Double-click the topic you want to return to (or press Tab to select the topic, and then press Enter). If 

necessary, use the scroll bar to see more topics. 

The History window stays open until you close it or quit Help. 

To close the History window
n Double-click the Control-menu box. 



 Choosing a jump 
Help topics can include graphics and text that link to other Help topics or to more information about the 
current topic. These are called jumps. Jumps are usually identified by a color and an underline (unless the
jump is a graphic). When you point to a jump, the pointer changes to a hand shape. 

To choose a jump
n Point to the text or graphic, and click with the mouse button. 
n Press Tab to select the jump, and then press Enter. 
n You can press Shift+Tab to move backward through a series of jumps.

If the jump you choose is linked to another topic, that topic appears in the Help window. Sometimes a 
jump is linked to information that appears in a pop-up window or a secondary window. 
Note: When information is displayed in a pop-up window, the size of the pop-up window is proportional to 
the size of the main Help window. If you want the pop-up window to be larger, you need to change the 
size of the main Help window. 

To display all jumps in a topic
n Press Ctrl+Tab. 

To close a pop-up window
n Click anywhere on the screen
n Press any key. 

To close a secondary window
n Double-click the Control-menu box.
n Press Alt+Spacebar to open the Control menu, and then choose Close.



 Scrolling through a Help topic 
If the information in a Help topic doesn't fit in the window, use the scroll bar.

To scroll through a Help topic
n Click one of the scroll arrows to scroll one line at a time, or drag the scroll box to scroll quickly through 

a topic. 
n Use the arrow keys to scroll up or down. 

To scroll up or down, one window at a time
n Click above or below the scroll box in the scroll bar. 
n Use the PAGE UP and PAGE DOWN keys. 



 Keeping Help on top of other windows 
When you first open Help, the Help window appears on top of other windows. If you select another 
window, it might cover up the Help window. 
You can choose to keep the Help window on top of other windows even when you switch to other 
applications. This can be useful if you are using Help to follow a step-by-step procedure in your 
application. 
Note: If you minimize a Help window that is on top, its icon also appears on top of other windows. 

Viewing an application and Help together



 Viewing an application and Help together 
When you use Help, you may want to change the size of the Help window and move it so that you can 
see both the Help window and your application window. By positioning windows so that they are both 
visible, you can follow step-by-step procedures without having to switch between windows. Another way 
to make sure that you can see both Help and your application is to keep the Help window on top of the 
application window while you work. 

To change the size of the Help window
n Drag the corner or border of the window until the window is the size you want. 

To move the Help window
n Drag the title bar of the window to the new location. 

For more information on moving and sizing windows, see your Windows documentation. 

Keeping Help on top of other windows



 Opening another Help file 
You can open a Help file for any application that offers Help. You do not have to be using the application 
to open its Help file. For example, you can be working in Windows Notepad and open the Help file for 
Windows Program Manager to read about group windows.

To open another Help file
1 From the File menu in Help, choose Open. 
2 In the File Name box, select the name of the Help file you want to open. 
n If the file you want to open is not in the current directory, select a different directory in the Directories 

box and click OK. Then select a Help file in the File Name box. 
n If the file you want is not on the current drive, open the Drives box, and select a drive. Then select a 

Help file in the File Name box. 
1 Click OK. 



 Glossary 
Click an entry to read its definition
Annotation File
Application Help button bar
Back button Jump
Clipboard Maximize
Command Minimize
Contents button Paste
Control-menu box Pointer
Copy Scroll bar
Cut Search button
Default printer Topic
Dialog box Wrap
Document



 Annotating a Help topic
You can add your own comments to a Help topic. When you annotate a Help topic, Help places a paper-
clip icon to the left of the topic title to remind you that you have added text to this topic. 

For help on annotating Help topics, choose one of the following tasks: 
Viewing an Annotation
Removing an Annotation
Adding text to a Help topic
Copying and pasting an Annotation



 Viewing an Annotation 
If you have added comments to a Help topic, you can view them at any time. 

To view an annotation
1 Click the paper-clip icon to the left of the topic title.
2 When you finish viewing the annotation, click the Cancel button. 



 Removing an Annotation 
If you no longer need your comments about a Help topic, you can remove the annotation. 

To remove an annotation
1 Select the annotation you want to remove by clicking the paper-clip icon to the left of the topic title. 
2 Click the Delete button. 



 Adding text to a Help topic 
You can add your own comments and notes to a Help topic and view this information later.

To add text to the current Help topic
1 From the Edit menu in Help, choose Annotate. 
2 In the Annotate dialog box, type the text you want to add. If you make a mistake, press BACKSPACE 

to remove any unwanted characters, and continue typing. Text wraps automatically, but you can end a 
line before it wraps by pressing Enter. 

3 Click the Save button. 



 Copying and pasting an Annotation 
You can copy text from an annotation and paste it into another annotation in Help or into a document. You
can also paste text from documents into annotations. 

To copy an annotation
1 Select the annotation you want to copy by clicking the paper-clip icon to the left of the topic title. 
2 To copy the annotation to the Clipboard, click the Copy button. If you want to copy only a portion of the

annotation, select the text that you want to copy onto the Clipboard, and then click the Copy button. 
You can drag the mouse pointer over text to select it. Or press and hold down Shift while you use the 
arrow keys to select text. 

3 Click the Save button. 

To paste an annotation
4 Copy onto the Clipboard the text you want to paste into the annotation. 
5 In the Help topic where you want to paste the annotation, click the paper-clip icon to the left of the title.
6 To paste the contents of the Clipboard at the beginning of the topic, click the Paste button.
7 Click the Save button. 



 Defining and using Bookmarks 
Just as you can place bookmarks in a book to mark specific references, you can place bookmarks in Help
topics you use frequently. After you have placed a bookmark in a topic, you can access that topic quickly 
from the Bookmark menu. 

To place a bookmark in the current topic
1 From the Bookmark menu in Help, choose Define. 
2 In the Bookmark Name box, the topic title appears. If you want to use a different name to identify the 

bookmark, type a name in this box. 
3 Click OK. 

The bookmark name now appears on the Bookmark menu in Help. 

To view a topic that has a bookmark
n From the Bookmark menu in Help, choose the bookmark name for the topic you want to view. 

Underlined numbers precede the first nine bookmark titles. You can type the corresponding number to 
go quickly to a marked topic. 
If more than nine bookmarks have been defined, choose More from the Bookmark menu in Help. 
Select a bookmark in the Go To Bookmark box, and then click OK. 

To remove a bookmark
1 From the Bookmark menu in Help, choose Define. 
2 Select the bookmark you want to remove. 
3 Click the Delete button. 

The bookmark name is removed from the Bookmark menu in Help. 



 Printing a Help topic 
You can print any Help topic. A topic prints on the default printer. If you have installed more than one 
printer, you can make any of them the default printer. You can also change the options for the default 
printer. 

To print the current Help topic
1 From the File menu in Help, choose Print Topic. 

To change printers and printer options
2 From the File menu in Help, choose Print Setup. 
3 Select the printer you want to use. 
4 To change the default printer options, click the Setup button. The options vary, depending on the 

printer you select. 
5 Select the options you want. 
6 Click OK to close the printer's Setup dialog box. 
7 Click OK. 

For help with the Setup dialog box, click the Help button or press F1 while using the dialog box. 

Note: You cannot print information that is in a pop-up window. 



 Copying a Help topic onto the Clipboard 
You can copy some or all of the text in a Help topic onto the Clipboard. From the Clipboard, you can paste
the text into another document.
Note: You cannot copy the graphics in a Help topic onto the Clipboard. 

To copy text in the current Help topic onto the Clipboard
1 From the Edit menu in Help, choose Copy. 
2 To copy all the text onto the Clipboard,
n Click the Copy button. 
n Select the text you want to copy onto the Clipboard, and then click the Copy button. 

You can paste the text that is on the Clipboard into a Help annotation or into a document from another 
application. 

To copy the entire topic directly onto the Clipboard
n Press Ctrl+Ins.

Annotating a Help topic



 File menu commands
Use the scroll bar to see more commands.
Open
Opens a Help file.

Print Topic
Prints the topic that is in the Help window. You can print only entire topics.

Print Setup
Sets printer options before printing a topic. You can select a printer and set or change options for the 
printer. The options available depend on the type of printer selected.

Exit
Quits Help and saves any annotations or bookmarks you created. 



 Edit menu commands 
Use the scroll bar to see more commands.

Copy
Copies the text of the current Help topic to the Clipboard.
From the Clipboard, you can paste the text into another application or document. 

Annotate
Adds text to the current Help topic.
Annotations are marked with a paper-clip icon, which appears in front of the topic heading. 



 Bookmark menu commands 
Use the scroll bar to see more commands.

Define
Places a bookmark in the current topic or removes a bookmark from any topic. The name you specify for 
the topic appears on the Bookmark menu. 

List of Bookmark Names
Appears after you have defined a bookmark. From this list, you can choose the bookmark for the topic 
you want to display in the Help window. 

More
Appears when you have defined more than nine bookmarks. Displays the complete list of bookmark 
names you have defined.



 Help menu commands (in Help)
Use the scroll bar to see more commands.

How to Use Help
Displays Contents for How To Use Help. Choosing this command is the same as pressing F1 while you 
are using Help.

Always on Top
Causes all Help windows to appear on top of other windows. After you choose this command, a shadow 
appears around the window border to indicate that the Help windows are on top. 

About Help
Displays version, mode, and copyright information about Windows.



 Help buttons 
Help buttons are located along the top of the Help window and enable you to move around easily in Help. 
If a feature is not available, its button name is dimmed. 

Note: Some applications may have additional Help buttons not described in the following table.

Button Function
Contents Displays Help Contents for the application you are using. If 

you are viewing the How to Use Help table of contents, 
clicking the Contents button will display the Timbuktu Pro table
of contents.

Search Lists all the words you can use to search for topics in the 
application's Help. By typing or selecting one of these words, 
you can search for and go to a specific Help topic.

Back Displays the last topic you viewed. You move back one topic at
a time in the order you viewed the topics. 

History Displays the last 40 topics you have viewed in the Windows 
session. The most recent topic viewed is listed first. To revisit a
topic, double-click it.

Shortcuts Displays the Keyboard Shortcuts topic in Timbuktu Pro Help.

To choose a Help button
Click the Help button you want. 



Annotation
A note or comment that you add to a Help topic. You can add comments to a Help topic by using the 
Annotate command on the Edit menu.



Application
A computer program used for a particular kind of work, such as word processing. This term is often used 
interchangeably with "program."



Back button
Goes back to the Help topic you have just viewed. Use this button to backtrack through the topics you 
have viewed so far. The Back button is in the Help button bar near the top of the Help window.



Clipboard
A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



Command
A word or phrase, usually found on a menu, that you choose in order to carry out an action. You choose a 
command from a menu or type a command at the MS-DOS prompt. You can also type a command in the 
Start/Run dialog box.



Contents button
Displays the active applications' Help Contents, where you can choose the Help topic you want. It is in the
Help button bar near the top of the Help window.



Control-menu box
The icon at the left of the title bar.
 
This icon opens the Control menu for a window.



Copy
The Copy command duplicates the highlighted text and places the duplicate on the Clipboard.



Cut
The Cut command removes the highlighted text and places it onto the Clipboard.



Default printer
The printer that is used if you choose the Print command without first specifying which printer you want to 
use with an application. You can have only one default printer; it should be the printer you use most often.



Dialog box
A window that appears temporarily to request or supply information. Many dialog boxes have options you 
must select before Windows can carry out a command.



Document
Whatever you create with an application, including information you type, edit, view, or save. A document 
may be a business report, a spreadsheet, or a picture, for example.



File
A collection of information that has been given a name and is stored on a disk. This information can be a 
document or an application.



Help button bar
Contains the Help buttons you can use to move to topics. It is located near the top of the Help window.



Jump
Text, graphics, or parts of graphics that provide links to other Help topics or to more information about the 
current topic. The pointer changes shape whenever it is over a jump. If you choose a jump that is linked to
another topic, that topic will appear in the Help window. If you choose a jump that is linked to more 
information, the information will appear in a pop-up window on top of the main Help window.



Maximize
Enlarge a window to its maximum size by using the Maximize button (at the right of the title bar).



Minimize
Reduce a window to an icon by using the Minimize button (at the right of the title bar).



Paste
The Paste command copies the contents of the Clipboard to the location indicated by your cursor.



Pointer
The arrow-shaped cursor on the screen that follows the movement of a mouse (or other pointing device) 
and indicates which area of the screen will be affected when you press the mouse button. The Pointer 
may change shape during certain tasks.



Scroll bar
A bar that appears at the right and/or bottom edge of a window or list box whose contents are not 
completely visible. Each scroll bar contains two scroll arrows and a scroll box, which enable you to scroll 
through the contents of the window or list box.



Search button
Displays the words you can use to search for related topics. Use this button to look for topics related to a 
particular word. It is located in the Help button bar near the top of the Help window.



Topic
Information in the Help window. A Help topic usually begins with a title and contains information about a 
particular task, command, or dialog box.



Wrap
To continue to the next line rather than stopping when the cursor reaches the end of the current line.



  Setting up your Timbuktu Pro
Timbuktu Pro on your desktop 
Configuring user access 
Changing your Timbuktu Pro preferences 



 Timbuktu Pro on your desktop
Starting Timbuktu Pro 
Setting your Master Password
Exiting Timbuktu Pro without shutting it down 
Stopping Timbuktu Pro



 Configuring user access
Registered users 
Admitting an Ask For Permission user
Checking for users
Disconnecting a remote user 
Keeping users out
Clearing Previous Users
Checking the Activity Log
Granting a service to all guests
Granting a service to Ask For Permission users
Remove a service from user access 



 Changing Timbuktu Pro preferences
To change the Timbuktu preferences:

1 Choose Preferences from the Setup menu. The Preferences dialog box appears.
2 Select a tab to set the General, Observe/Control, Send, Notify and Master Password Timbuktu 

preferences.



 Customize Timbuktu Pro's General preferences
The General tab lets you determine how Timbuktu Pro is opened at the time Windows is started on 
your computer. It also allows you to specify the computer name and maximum number of items in the 
Recent Connections and TCP/IP Address lists.

To change your General options:
1 Choose Preferences from the Setup menu.
2 Click the General tab.

3 Specify a Timbuktu Pro computer name.
4 Select the Start Timbuktu Pro as a Service option, if you want the Timbuktu Pro application to be 
started as a service. This lets you control your computer and then type in your login information. You can 
even use user services such as Exchange without logging in.
5 You can set the maximum number of items to be stored in the Recent Connections and the 
TCP/IP Address lists in the respective fields.

6 Click OK to close the Preferences window.



 Make Timbuktu Pro launch as a Service
By default, the Timbuktu Pro application is started automatically as soon as Windows has loaded on your 
computer. You may prefer to start Timbuktu Pro manually, or you may want Timbuktu Pro to launch as a 
service.

To launch Timbuktu Pro as a service:
1 Choose Preferences from the Setup menu.
2 Select the General tab.
3 Select the Start Timbuktu Pro as a Service option. This lets you control your computer and then type in

your login information. You can even use user services such as Exchange without logging in.
4 Click OK to close the Preferences window.



 Customize Timbuktu Pro's Observe/Control service
You can customize the Observe/Control window to scroll manually or automatically. You can optionally
blank out your desktop wallpaper to speed up screen-sharing performance.

To change your Observe options:
1 Choose Preferences from the Setup menu.
2 Click the Observe/Control tab.

3 In the Observe/Control window panel:
n Select Automatically scroll the window to scroll a screen-sharing window automatically when your
mouse pointer approaches the edge of the window or when the pointer on the displayed desktop moves 
out of view.
n Select Manually scroll the window to cancel the automatic scrolling described above.

Note: Since there are no scroll bars when a screen-sharing window is maximized, a maximized window 
always scrolls automatically.

Display Wallpaper While Being Controlled or Observed:
n Switch off the Display desktop wallpaper when users Observe/Control my screen option to remove the

Windows wallpaper from the desktop of your PC whenever a remote user is controlling or observing 
your computer. Shutting off the wallpaper should increase the speed of Timbuktu Pro. The wallpaper 
reappears when the remote control session ends.

Screen Blanking
n Screen blanking prevents anyone viewing the screen from knowing that the computer is being 

controlled. When the host's screen is blanked, it will remain frozen with the "Workstation Locked", 
(blank black screen) or "Begin Logon" dialog boxes displayed. This initial condition of the host's screen
won't change until the remote guest has disconnected.

The remote user will not be able to see what you are doing on the desktop, but the remote user may 
be able to see the cursor move and hear any audio that your computer may generate.



Click OK to close the Preferences window.



 Customize Timbuktu Pro's Send service
You can customize Timbuktu Pro to display Send notes as windows or as icons. These notifications 
tell you when a user has sent a message and/or enclosures to you. In addition, you can designate 
how much of your disk space should not be available for temporary storage of FlashNotes and their 
enclosures. 

To change your Send options:
1 Choose Preferences from the Setup menu.
2 Click the Send tab.

3 In the When a note arrives on my computer panel.
Select Show in a full-sized window to see newly received FlashNote and attached enclosures 
immediately. Select Show as a minimized icon to display the FlashNote as an icon in the taskbar. This 
serves as a reminder to the user that a message has arrived.
4 In the Disk Usage panel:

To limit the amount of disk space used by files sent to your files received directory, enter the desired 
number of megabytes in the Megabytes of diskspace protected from use by FlashNotes field. This 
number defines the amount of disk space that you always want to keep free from use by the Send service
and thereby prevents users from filling up your disk with FlashNotes and enclosures.

Files transferred using the Send function are stored in a files received folder. Specify the location of the 
files received directory on your PC in the Save files inside this folder field.

If a user attempts to send enclosures—files and/or folders—that would require more disk space to store 
on your computer than you have designated in your Send options, Timbuktu Pro tells the user that there 
isn't enough disk space to carry out the file transfer.

This option does not restrict files transferred using the Exchange service.

5 Click OK to close the Preferences window.



 Customize Timbuktu Pro's Notify service
When users use the Notify service, they are asking to be notified when your Timbuktu Pro computer 
becomes active. The way Timbuktu Pro honors this request depends on how you have set the Notify 
option.

To change the Notify option:
1 Choose Preferences from the Setup menu.
2 Select the Notify tab.

3 In the If someone asks to be notified when I become active panel:

Select Prompt me for an answer to know who is asking for notification before Timbuktu Pro sends them a 
notification. You can then choose to notify or not to notify the user that you are available at your computer.

Select Answer automatically (based on mouse and keyboard activity)    if it’s OK for all users to whom 
you've granted the Notify service to know when your computer has become active based on keyboard 
and mouse activity. Whenever a remote user asks for notification, Timbuktu Pro will notify that user that 
you are active—based on your keyboard and mouse activity—without telling you who is asking for 
notification.

4 Click OK to close the Preferences window.



 Setting your master password 
By creating a master password, you can protect access to those parts of Timbuktu Pro that allow you 
to change Timbuktu Pro's configuration, that is the Security, and Preferences dialog boxes. After 
you've created a master password, Timbuktu Pro will ask you to type it whenever you attempt to open
either the Preferences or the Security windows.

To create a master password:
1 Choose Preferences from the Setup menu.
2 Click the Master Password tab.

3 Type the new password    in the Password box. The characters of the master password are 
always displayed as asterisks. Passwords are case sensitive.
4 Press the Tab key to move to the Confirm box and re-type the master password again in the 
Confirm box.
5 Click OK to close the Preferences window.

Note: Timbuktu Pro does not let you close the Preferences dialog box until the Master Password and 
Confirmation fields match. If you lose your Master Password you must
un-install and re-install.

To change your master password:
6 Choose Preferences from the Setup menu.
7 Click the Master Password tab. The Password text is selected.
8 Type the password    in the Password box. 
9 Press the Tab key to move to the Confirm box and re-type the master password in the Confirm box.
10Click OK to close the Preferences window.

Note: Timbuktu Pro does not let you close the Preferences dialog box until the Master Password and 
Confirmation fields match.

To remove your master password:
11Choose Preferences from the Setup menu.
12Select the Master Password tab. The Password text is selected.
13Press the Delete key and press the Tab key to move to the Confirm box.
14Press the Delete key again in the Confirm box.
15Click OK. 





Netopia Technical Support
Netopia, Inc is committed to providing its customers with reliable products and documentation backed up 
with excellent technical support.

Before calling Netopia
Choose Troubleshooting from the Help menu for a solution to your problem. Use the Index and Look For 
functions of the Timbuktu Pro Guide to generate references to your topic of concern.

Environment profile

• Locate your product code and version number. This information can be found either by running 
Timbuktu Pro and selecting About Timbuktu Pro from the Help menu or by looking at the label on the 
original disk.

Product code: __________________________________________

Version number: ________________________________________

• What are the CPU and clock speed of the PC on which you encountered the problem (for example; 
486/66 MHz or Pentium 66 MHz)

CPU and clock speed: ____________________________________

• What Windows versions are you running?

Windows version: _______________________________________

Service Pack Version: ___________________________________

• How much memory (RAM) is on your PC?

Amount of RAM: _______________________________________

• Video Adapter: ____________________________________

Video Chip set: ________________________________________

Resolution: ________________________________________

• What error messages have you received? ____________________________

How to reach us
We can help you with your problem more effectively if you have completed the Environment Profile in the 
previous section. If you contact us by telephone, please be at the site of the problem, prepared to 
reproduce it and try some troubleshooting steps.

When you are prepared, contact Netopia Customer Service by telephone, fax, mail, or email:

Phone: (510)    814-5000
Fax: (510)    814-5023

Netopia, Inc.
Customer Service
2470 Mariner Square Loop
Alameda, California    94501
USA

http://www.netopia.com/support/contact_us.html

Netopia Bulletin Board Service: (510) 865-1321 or ftp://bbs.netopia.com



FAX-Back
This service provides technical notes which answer the most commonly asked questions, and offer 
solutions for many common problems encountered with products.

• FAX-Back: (510)    814-5040

Network Services
Product information can be found in the following bulletin boards:

n Internet via anonymous FTP to ftp.netopia.com
n World Wide Web Server: www.netopia.com
n Netopia Timbuktu Pro addresses via TCP/IP:

Macintosh version: timbuktu.farallon.com or 163.176.4.43

Windows version: tb2prowin.farallon.com or 163.176.4.44

Outside of the United States and Canada
If you are not located in the United States or Canada, you can get service locally by contacting your 
nearest Netopia reseller or distributor. For a worldwide list of our distributors see www.netopia.com.




